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Safety information

Always follow basic safety precautions when 
using this product to reduce risk of injury from 
fire or electric shock.

- Read and understand all instructions in the 
documentation that comes with the printer.

- Observe all warnings and instructions marked 
on the product.

- Unplug the printer from wall outlet and 
remove battery pack before cleaning.

- Do not install or use this product near water, 
or when you are wet.

- Install the product securely on a stable 
surface.

- Install the product in a protected location 
where no one can step on or trip over the line 
cord, and the line cord cannot be damaged.

- If the product does not operate normally, see 
Solve a problem.

- There are no user-serviceable parts inside. 
Refer servicing to qualified service personnel.

- Use only the battery pack supplied or sold by 
HP for this printer.
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1 How do I?

● Get started

● Print

● Copy and scan

● Web services

● Work with cartridges

● Solve a problem
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2 Get started

This guide provides details about how to use the printer and how to resolve problems.

● Accessibility

● HP EcoSolutions (HP and the Environment)

● Understand the printer parts

● Use the printer control panel

● Paper basics

● Load paper

● Load an original in the document feeder

● Automatic Paper Size Detection

● Update the printer

● Use the printer battery

● Open the HP printer software (Windows)

● Turn the printer off 

Accessibility
The printer provides a number of features that make it accessible for people with disabilities.

Visual

The HP software provided with the printer is accessible for users with visual impairments or low vision by 
using your operating system's accessibility options and features. The software also supports most assistive 
technology such as screen readers, Braille readers, and voice-to-text applications. For users who are color 
blind, colored buttons and tabs used in the HP software have simple text or icon labels that convey the 
appropriate action.

Mobility

For users with mobility impairments, the HP software functions can be executed through keyboard 
commands. The HP software also supports Windows accessibility options such as StickyKeys, ToggleKeys, 
FilterKeys, and MouseKeys. The printer doors, buttons, paper trays, and paper-width guides can be operated 
by users with limited strength and reach.

Support

For more information about accessibility solutions for HP products, visit the HP Accessibility and Aging 
website (www.hp.com/accessibility).

For accessibility information for OS X, visit the Apple website at www.apple.com/accessibility.
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HP EcoSolutions (HP and the Environment)
HP is committed to helping you optimize your environmental footprint and empowering you to print 
responsibly—at home or in the office.

For more detailed information about environmental guidelines that HP follows during the manufacturing 
process, see Environmental product stewardship program. For more information about HP's environmental 
initiatives, visit www.hp.com/ecosolutions.

● Manage power

● Quiet Mode

● Optimize Printing Supplies

Manage power
Use Sleep Mode and Auto-Off to conserve electricity.

Sleep mode

Power usage is reduced while in Sleep mode. After initial setup of printer, the printer will enter Sleep mode 
after five minutes of inactivity.

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, touch  (EcoSolution).

2. Touch Sleep Mode, and then touch the desired option.

Auto-Off

This feature turns the printer off after 15 minutes of inactivity to help reduce energy use. Auto-Off turns the 
printer off completely, so you must use the Power button to turn the printer back on.

If your printer supports this energy saving feature, Auto-Off is automatically enabled or disabled depending 
on printer capabilities and connection options. Even when Auto-Off is disabled, the printer enters Sleep mode 
after 5 minutes of inactivity to help reduce energy use

● Auto-Off is enabled when the printer is turned on, if the printer does not have network, fax or Wi-Fi 
Direct capability, or is not using these capabilities.

● Auto-Off is disabled when a printer’s wireless or Wi-Fi Direct capability is turned on or when a printer 
with fax, USB, or Ethernet network capability establishes a fax, USB, or Ethernet network connection.

TIP: To conserve battery power, you can enable Auto-Off, even when the printer is connected or wireless is 
turned on.

To manually enable Auto-Off from the HP printer software

1. Connect the printer to your computer if they are disconnected.

2. Launch the printer software installed on your computer.

3. From the software, click Print on the toolbar and select Maintain Your Printer.

A toolbox window opens.

4. From the Advanced Settings tab, select Change for the Auto-Off option.
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5. From the time period list, select one for Auto-Off inactivity time and then click OK.

6. Click Yes when prompted.

Auto-Off is enabled.

To manually enable Auto-Off from the printer control panel

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, and then touch  (Setup).

2. Touch Power Management, and then Auto-Off.

3. Choose an inactivity time period from the list.

A messages shows up, prompting you whether to always enable Auto-Off.

4. Touch Yes.

Auto-Off is enabled.

Quiet Mode
Quiet Mode slows down printing to reduce overall noise without affecting print quality. It only works for 
printing with normal print quality on plain paper. Quiet Mode is off by default.

To reduce printing noise, turn on Quiet Mode.

To print at normal speed, turn off Quiet Mode.

NOTE: Quiet Mode does not work if you print photos or envelopes.

To turn on Quiet Mode from the printer control panel

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, and then touch  (Setup).

2. Touch Quiet Mode.

3. Touch Off next to Quiet Mode to turn it on.

To turn Quiet Mode on or off from the printer software (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. Click Quiet Mode .

3. Select On or Off .

4. Click Save Settings.

5. Click OK.

To turn Quiet Mode on or off from the printer software (OS X)

1. Open HP Utility.

NOTE:  HP Utility is located in the HP folder in the Applications folder. 

2. Select the printer.

3. Click Quiet Mode .
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4. Select On or Off .

5. Click Apply Now.

To turn Quiet Mode on or off from the Embedded Web Server (EWS)

1. Open the EWS. For more information, see Open the embedded web server.

2. Click the Settings tab.

3. In the Preferences section, select Quiet Mode , and then select On or Off .

4. Click Apply.

Optimize Printing Supplies
To optimize printing supplies such as cartridge and paper, try the following:

● Recycle used original HP cartridges through HP Planet Partners.

For more information, visit www.hp.com/recycle.

● Optimize paper usage by printing on both sides of the paper.

● Change the print quality in the printer driver to a draft setting. The draft setting uses less ink.

● Only clean the cartridges when needed. Doing so wastes ink and shortens the life of the cartridges.

Understand the printer parts
This section contains the following topics:

● Front and side view

● Document feeder 

● Printing supplies area

● Back view

Front and side view

1 Power button
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2 Power light

3 Battery light

● Lights up when the battery installed in the printer is charging.

● Blinks when there is an issue with the battery, such as the battery is faulty or is too hot or too cold to charge.

4 Wireless light: Indicates the status of the printer's wireless connection

● Solid blue light: Indicates that wireless connection has been established and you can print.

● Blinking light: Indicates that the wireless feature needs user action. Refer to the message on the printer display.

● If the wireless light is off, wireless is turned off.

5 Output slot

6 Control panel

7 USB host port

● Connects to a USB flash drive so that you can print photos from the drive. For more information on how to print photos 
from a USB flash drive, see Print photos.

● When the printer is turned on, it can also be used to charge a mobile device (such as a smart phone) connected to the 
USB host port.

8 Input tray paper-width guides

9 Input tray

10 Input tray extension

Document feeder

1 Document feeder: Load the original to be copied or scanned

2 Document feeder tray extension

3 Document feeder tray

4 Document feeder paper-width guides
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Printing supplies area

1 Cartridge access door

2 Cartridge latch

3 Cartridge slot

4 Cartridge

NOTE: Cartridges should be kept in the printer to prevent possible print quality issues or damage. Avoid 
removing supplies for extended periods of time. 

Back view

1 Battery cover

2 Battery status button: Press to show the battery status. For more information, see Check the battery status.

3 USB port

● Connects the printer to your computer with the USB cable provided.

● Charges the battery installed in the printer. For more information on charging the battery, see Charge the battery.

4 Power input

5 Security lock slot: Allows you to insert a security cable to lock your printer.

Use the printer control panel
This section contains the following topics:
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● Lift the printer control panel

● Overview of buttons

● Printer control panel display icons

● Function tabs

● Use the Home screen

● Change printer settings

● Dashboard

● Use shortcuts

Lift the printer control panel
You can use the printer control panel while it is lying flat, or lift it up for easier viewing and use.

To lift the printer control panel

▲ Press the top of the printer control panel and it rises automatically.

NOTE: Return the printer control panel to its original position by pushing down the top side until it 
clicks into place.

Overview of buttons
The following illustration provides quick reference to the printer control panel features.
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Label Name and Description

1 Control panel display: Touch the screen to select menu options, or scroll through the menu items. For information about the icons 
that appear on the display, see Printer control panel display icons.

2 Back button: Returns to the previous screen.

3 Home button: Returns to the home screen from any other screen.

4 Help button: Opens the Help menu when on the Home screen, displays the help for a selected menu option, or provides more 
information about the current screen.

Printer control panel display icons
To access the icons, touch or swipe down the tab at the top of a screen to open the Dashboard, and then touch 
the icon.

Icon Purpose

Setup: Allows you to change preferences and other maintenance settings, set up network, Wi-Fi Direct, Web 
Services, and also generate reports. 

Wireless: Displays wireless status and menu options. For more information, see Set up the printer for wireless 
communication.

NOTE: If the printer’s network connection is not set up, the display shows  (Wireless) by default.

HP ePrint: Displays the Web Services Summary menu, where you can check ePrint status details, change ePrint 
settings, or view the printer email address. For more information, see HP ePrint .

Wi-Fi Direct: Displays the status, name, and password for Wi-Fi Direct, and the number of devices connected. You 
can also change settings and print a guide. For more information, see Use Wi-Fi Direct.

Ink: Displays the estimated ink levels.
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Icon Purpose

HP EcoSolutions: Displays a screen where you can configure some of the printer's environmental features.

Battery: Indicates battery level if battery is installed.

Function tabs
Function tabs are located at the bottom of the screen.

Function tab Purpose

 (Shortcuts)
Access to shortcuts you have created.

Copy Copy document.

Scan Scan document to email, computer or USB flash drive.

Photo Print photo from USB flash drive.

Apps Access to the apps for your printer.

Use the Home screen

The Home screen displays after you touch  (Home).

It provides a main menu for you to access the functions offered with the printer.

Change printer settings
Use the printer control panel to change the printer function and settings, print reports, or get help for the 
printer.

TIP: If the printer is connected to a computer, you can also change the printer settings using the printer 
management tools in the software.

For more information about these tools, see Printer management tools.

To change the printer settings

To change the printer settings or print reports, use the options available on the Setup menu.

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, and then touch  ( Setup ).

2. Touch and scroll through the screens.

3. Touch the screen items to choose options.
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TIP: Touch  (Home) return to the Home screen.

Dashboard
The Dashboard on the printer control panel lets you access the icons on the display, check the status of the 
printer, or monitor and manage current and scheduled printer tasks.

To open the Dashboard, touch or swipe down the tab  at the top of a screen on the printer control 
panel.

Use shortcuts
Using shortcuts on the printer control panel, you can create a collection of the tasks frequently used from all 
features available in the function folders.

Once shortcuts are created, you can access to them on the Home screen or through the Shortcuts tab.

To create a shortcut

1. Select one of the function tabs.

2. Touch and hold the desired icon until a message is displayed prompting you to drag the icon to the 
bottom of the control panel display to create a shortcut.

3. Drag the icon to the bottom area of control panel display.

4. After you drop the icon, the shortcut is created.

5. Touch  (Shortcuts) to verify that the shortcut works.

To delete a shortcut

1. Touch  (Shortcuts).

2. Touch and hold the desired icon until a message is displayed prompting you to drag the icon to the 
bottom of the control panel display to delete a shortcut.

3. Drag the icon to the bottom area of control panel display.

4. After you drop the icon, the shortcut is deleted.

5. Verify that the shortcut is deleted.

Paper basics
The printer is designed to work well with most types of office paper. It is best to test a variety of print paper 
types before buying large quantities. Use HP paper for optimum print quality. Visit the HP website at 
www.hp.com for more information about HP paper.

HP recommends plain papers with the ColorLok logo for printing everyday documents. All 
papers with the ColorLok logo are independently tested to meet high standards of 
reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, 
and that dry faster than ordinary plain papers. Look for papers with the ColorLok logo in 
a variety of weights and sizes from major paper manufacturers.

ENWW Paper basics 11

http://www.hp.com


This section contains the following topics:

● Recommended papers for printing

● Order HP paper supplies

● Tips for selecting and using paper

Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically designed for the type 
of project you are printing.

Depending on your country/region, some of these papers might not be available.

Business documents

● HP Premium Presentation Paper 120g Matte or HP Professional Paper 120 Matt

This paper is a heavy two-sided matte paper perfect for presentation, proposals, reports, and 
newsletters. It is heavy weight for an impressive look and feel.

● HP Brochure Paper 180g Glossy or HP Professional Paper 180 Glossy

These papers are glossy-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures, 
mailers, and calendars.

● HP Brochure Paper 180g Matte or HP Professional Paper 180 Matt

These papers are matte-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures, 
mailers, and calendars.

Everyday printing

All the papers listed for everyday printing feature ColorLok Technology for less smearing, bolder blacks, and 
vivid colors.

● HP Bright White Inkjet Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-
sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers.

● HP Printing Paper

HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more 
substantial than documents printed on standard multipurpose. It is acid-free for longer lasting 
documents.

● HP Office Paper

HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other 
everyday documents. It is acid-free for longer lasting documents.
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Photo printing

● HP Premium Plus Photo Paper

HP Premium Plus Photo Paper is HP’s highest-quality photo paper for your best photos. With HP 
Premium Plus Photo Paper, you can print beautiful photos that are instant-dry so you can share them 
right off the printer. The printer supports several sizes, including A4, 8.5 x 11 inches, 4 x 6 inches (10 x 
15 cm), and 5 x 7 inches (13 x 18 cm) in two finishes - glossy or soft gloss (semi-gloss). Ideal for framing, 
displaying, or gifting your best photos and special photo projects. HP Premium Plus Photo Paper delivers 
exceptional results with professional quality and durability.

● HP Advanced Photo Paper

This glossy photo paper features an instant-dry finish for easy handling without smudging. It resists 
water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-
processed photo. It is available in several sizes, including A4, 8.5 x 11 inches, 10 x 15 cm (4 x 6 inches), 
13 x 18 cm (5 x 7 inches). It is acid-free for longer lasting documents.

● HP Everyday Photo Paper

Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This 
affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper 
with any inkjet printer. It is available in glossy finish in several sizes, including A4, 8.5 x 11 inches, 5 x 7 
inches and 4 x 6 inches (10 x 15 cm). It is acid-free for longer lasting documents.

● Hagaki paper (for Japan)

Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This 
affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper 
with any inkjet printer.

Order HP paper supplies
The printer is designed to work well with most types of office paper. Use HP paper for optimum print quality.

To order HP papers and other supplies, go to www.hp.com . At this time, some portions of the HP website are 
available in English only.

HP recommends plain papers with the ColorLok logo for printing everyday documents. All papers with the 
ColorLok logo are independently tested to meet high standards of reliability and print quality, and produce 
documents with crisp, vivid color, bolder blacks and shorter dry-time than ordinary plain papers. Look for 
papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

Tips for selecting and using paper
For the best results, observe the following guidelines.

● Load only one type of paper at a time into the input tray.

● Make sure the paper is loaded correctly.

● Do not overload the input tray.

● To prevent jams, poor print quality, and other printing problems, avoid loading the following paper in the 
input tray:

— Multipart forms

— Media that is damaged, curled, or wrinkled

— Media with cutouts or perforations
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— Media that is heavily textured, embossed, or does not accept ink well

— Media that is too lightweight or stretches easily

— Media that contains staples or clips

Load paper
When loading paper, ensure that paper is properly loaded in the input tray, adjust the paper-width guides till 
they touch the edges of the paper, and make sure the printer detects the correct paper size. If the detected 
paper size or type needs adjustment, change the paper settings in the printer control panel. To turn on the 
feature to automatically detect paper size, see Automatic Paper Size Detection.

● If the feature to automatically detect paper size is turned off or is not working properly, change the 
paper size setting from the printer control panel.

● If the feature to automatically detect paper size is turned on, adjust the paper-width guides till they 
touch the edge of the paper so that the printer can detect the paper width.

● If you are prompted with a message that indicates an unknown paper size, follow instructions on the 
printer control panel display to adjust the paper-width guides and/or change the paper size.

● If you are loading a custom paper size, adjust the paper-width guides to a width that is closest to the 
custom width, so the printer can detect the closest width. If necessary, change the paper size from the 
printer control panel.

To load standard-size paper

1. Lift the input tray.

2. Slide the paper-width guides out as far as possible.

3. Insert the paper print-side up and slide the paper-width guides till they fit snugly against the sides of 
the paper.

Do not use the paper illustrated in the following graphic.
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NOTE:

● Do not load paper while the printer is printing.

● After inserting paper, be sure to adjust the paper-width guides so that the printer can detect the 
paper width.

To load envelope

1. Lift the input tray.

2. Slide the paper-width guides out as far as possible.

3. Insert the envelope print-side up and the long-edge flap on the left or the short-edge flap at the top.

NOTE:

● Do not load envelopes while the printer is printing.

● After inserting paper, be sure to adjust the paper-width guides so that the printer can detect the 
paper width.

4. Slide the paper-width guides till they fit snugly against the sides of the envelope.

To load cards and photo paper

1. Lift the input tray.

ENWW Load paper 15



2. Slide the paper-width guides out as far as possible.

3. Insert the paper print-side up and slide the paper-width guides till they fit snugly against the sides of 
the paper.

NOTE:

● Do not load paper while the printer is printing.

● After inserting paper, be sure to adjust the paper-width guides so that the printer can detect the 
paper width.

Load an original in the document feeder
You can copy or scan a document by placing it in the document feeder.

To load an original in the document feeder

1. Lift the input tray and then open the document feeder tray.

2. Load your original print-side down into the document feeder.

a. If you are loading an original printed in portrait orientation, place the pages so that the top edge of 
the document goes in first. If you are loading an original printed in landscape orientation, place the 
pages so that the left edge of the document goes in first.

b. Slide the paper into the document feeder until you hear a tone or see a message on the printer 
control panel display indicating that the loaded pages were detected.

TIP:

● For more help on loading originals in the document feeder, refer to the the engraved guides on the 
document feeder.

● If you are loading larger-sized media, pull up the document feeder tray extension.
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3. Slide the paper-width guides inward until they stop at the left and right edges of the paper.

Automatic Paper Size Detection
When this feature is turned on, the printer can automatically detect the width of paper loaded when you 
adjust the paper-width guides to fit the sides of the paper.

To turn on or off the feature to automatically detect paper size

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, touch  (Setup).

2. Touch Preferences.

3. Scroll down to Automatic Paper Size Detection and select On or Off.

Update the printer
By default, if the printer is connected to a network and Web Services has been enabled, the printer 
automatically checks for updates.

To update the printer using the printer control panel

1. On the printer control panel, touch  (Home) to display the Home screen.

2. Select Setup, Web Services Setup and then touch Update the Printer.

To update the printer using the embedded web server

1. Open the embeded web server (EWS).

For more information, see Embedded web server.

2. Click the Tools tab.

3. In the Printer Updates section, click Firmware Updates, and then follow the onscreen instructions.

NOTE:

● If a printer update is available, the printer downloads and installs the update, and then restarts.

● If prompted for proxy settings and if your network uses proxy settings, follow the onscreen instructions 
to set up a proxy server. If you do not have the details, contact your network administrator or the person 
who set up the network.
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Use the printer battery
Some models of the printer come with a lithium-ion rechargeable battery, which can be installed at the rear of 
the printer. To see the location, see Back view.

NOTE:

● The battery is also available for purchase as an optional accessory.

● To purchase, contact your local dealer or HP sales office, or visit store.hp.com .

Install or replace the battery
To install or replace the battery

1. Turn off the printer and disconnect the power.

2. If the printer control panel is lifted, press it down and close the printer top cover. For more information 
about the printer parts, see Understand the printer parts.

3. Remove the battery cover from the rear of the printer.

4. If you are replacing the battery, remove the original battery by lifting the latch and releasing the battery.

5. Insert the battery into the battery slot.

The battery status button is on the upper-right corner of the battery.
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6. Reinsert the battery cover.

To check the battery status, see Check the battery status.

Check the battery status

To check battery status from the battery

▲ Press the battery status button on the battery.

TIP: If the battery is installed in the printer, press similar button on the battery cover.

To check battery status from the printer control panel

▲ Touch  (Home) to display the Home screen, and then touch  (Battery).

Battery status

Battery status lights Number of lights Color of lights Battery level

5 White (Solid) 80%-100%

4 White (Solid) 60%–79%
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Battery status lights Number of lights Color of lights Battery level

3 White (Solid) 40%-59%

2 White (Solid) 20%-39%

1 White (Solid) 11%-19%

1 White (Blinking) 1%-10%

NOTICE: When the battery level 
reaches a very low level, the printer 

automatically turns off after 30 
seconds.

Off Not applicable The battery cannot be detected or is 
damaged, corrupted, or cannot be 

charged for some reason.

Charge the battery
The battery installed in the printer is charged when the printer is connected to an electrical supply through a 
power cable.

Charging the battery using AC power can take up to 2.5 hours. If AC power is removed and the printer is turned 
off, the battery can also be charged when the USB port on the rear of the printer is connected to the charging 
USB port of another device. The charging USB port must be able to supply a minimum of 1 ampere.

For example:

● USB charging port on a notebook computer (identified by a lightning symbol near the host port)

● USB charger that is connected to a wall outlet (can be generic or one used for mobile phones or tablets)

● USB charger that is connected to the power port in a car (can be generic or one used for mobile phones 
or tablets)

Store the battery

WARNING!

● To avoid potential safety issues, use only the battery provided with the printer or the battery purchased 
as an accessory from HP.

● To purchase, contact your local dealer or HP sales office, or visit store.hp.com.
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CAUTION:

● To prevent damage to a battery, do not expose it to high temperatures for extended periods of time.

● If the printer is unused and disconnected from external power for more than two weeks, remove the 
battery and store it separately.

● To prolong the charge of a stored battery, place it in a cool, dry place.

Dispose the used battery

WARNING! To reduce the risk of fire or burns, do not disassemble, crush, or puncture a battery; short the 
external contacts on a battery; or dispose of a battery in fire or water. Do not expose a battery to 
temperatures above 60°C (140°F).

Open the HP printer software (Windows)
After installing the HP printer software, depending on your operating system, do one of the following.

● Windows 10: From the computer desktop, click the Start button, click All apps, select HP, and then 
select the icon with the printer name.

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the icon with 
the printer name.

● Windows 8: On the Start screen, right-click an empty area on the screen, click All Apps on the app bar, 
and then select the icon with the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click the Start button, select 
All Programs, select HP, select the folder for the printer, and then select the icon with the printer name.

Turn the printer off
Turn the printer off by pressing  (Power) located on the printer. Wait until the power light turns off before 
unplugging the power cord or turning off a power strip. Any other different methods of turning off the printer 
is not correct.

CAUTION: If you incorrectly turn the printer off, the print carriage might not return to the correct position, 
causing problems with the cartridges and print quality issues.

ENWW Open the HP printer software (Windows) 21



3 Print

With this printer, you can print various medias such as documents, brochures, photos and envelopes from 
either computers, USB flash drives, or mobile devices (smart phones or tablets).

To print documents and photos from mobile devices (such as smart phones or tablets), visit the HP Mobile 
Printing website at www.hp.com/go/mobileprinting . If a local version of this website is not available in your 
country/region or language, you might be directed to the HP Mobile Printing site in another country/region or 
language.

NOTE: Most print settings are automatically handled by the software application. Change the settings 
manually only when you want to change print quality, print on specific types of paper, or use special features.

TIP: This printer includes HP ePrint , a free service from HP that allows you to print documents on an HP 
ePrint-enabled printer anytime, from any location, without any additional software or printer drivers. For 
more information, see HP ePrint .

● Print documents

● Print brochures

● Print on envelopes

● Print photos

● Print on special and custom-size paper

● Print on both sides (manually)

● Print with mobile devices

● Tips for print success

Print documents
To print documents (Windows)

1. Load paper in the input tray. For more information, see Load paper.

2. From your software, select Print.

3. Make sure your printer is selected.

4. To change settings, click the button that opens the Preferences dialog box.

Depending on your software application, this button might be called Properties , Options , Printer 
Setup , Printer , or Preferences .

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. On the Printing Shortcut tab, select a paper type from the Paper Type drop-down menu.

To change other print settings, click the other tabs.

For more printing tips, see Tips for print success.

22 Chapter 3   Print ENWW

http://www.hp.com/go/mobileprinting


NOTE: If you change the paper size, be sure to load the correct paper in the input tray.

6. Click OK to confirm the setups. The Preferences window closes.

7. Click Print or OK to begin printing.

To print documents (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

● Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the paper size ensure that you have loaded the correct paper.

● Select the orientation.

● Enter the scaling percentage.

4. Click Print.

Print brochures
To print brochures (Windows)

1. Load paper in the input tray. For more information, see Load paper.

2. From your software, select Print.

3. Make sure your printer is selected.

4. To change settings, click the button that opens the Preferences dialog box.

Depending on your software application, this button might be called Properties , Options , Printer 
Setup , Printer , or Preferences .

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. On the Printing Shortcut tab, select a brochure type from the Paper Type drop-down menu.

To change other print settings, click the other tabs.

For more printing tips, see Tips for print success.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray.

6. Click OK to confirm the setups. The Preferences window closes.

7. Click Print or OK to begin printing.

To print brochures (OS X)

1. From the File menu in your software application, choose Print.

2. Make sure your printer is selected.
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3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

a. Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the paper size ensure that you have loaded the correct paper.

b. From the pop-up menu, choose Paper Type/Quality, and then choose the option that provides the 
best quality or maximum dpi.

4. Click Print.

Print on envelopes
Avoid envelopes with the following characteristics:

● Very slick finish

● Self-stick adhesives, clasps, or windows

● Thick, irregular, or curled edges

● Areas that are wrinkled, torn, or otherwise damaged

Make sure the folds of envelopes you load in the printer are sharply creased.

NOTE: For more information about printing on envelopes, see the documentation available with the 
software program you are using.

To print envelopes (Windows)

1. Load envelopes in the input tray. For more information, see Load paper.

2. From your software, select Print.

3. Make sure your printer is selected.

4. To change settings, click the button that opens the Preferences dialog box.

Depending on your software application, this button might be called Properties , Options , Printer 
Setup , Printer , or Preferences .

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. On the Layout tab, select Landscape from the Orientation drop-down menu.

On the Layout or Paper/Quality tab, click Advanced button. In the Paper/Output area, select an 
envelope type from the Paper Size drop-down menu.

To change other print settings, click the other tabs.

For more printing tips, see Tips for print success.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray.

6. Click OK to confirm the setups. The Properties window closes.

7. Click Print or OK to begin printing.
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To print envelopes (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Select the appropriate envelope size from the Paper Size pop-up menu.

If you do not see options on the Print dialog, click Show Details.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper.

4. From the pop-up menu, choose Paper Type/Quality, and verify the paper type setting is set to Plain 
Paper.

5. Click Print.

Print photos
You can print a photo from either a computer or a USB flash drive.

CAUTION: Do not remove the USB flash drive from the printer USB port while it is being accessed by the 
printer. This can damage the files on the drive. When removing the USB flash drive, make sure the USB port 
light is not blinking.

NOTE: The printer does not support encrypted USB flash drives or USB flash drives using the NTFS file 
system.

Do not leave unused photo paper in the input tray. The paper might start to curl, which could impair the 
quality of your printout. Photo paper should be flat before printing.

TIP: You can use this printer to print documents and photos on your mobile device (such as a smartphone or 
tablet). For more information, visit the HP Mobile Printing website ( www.hp.com/go/mobileprinting ). At this 
time, this website might not be available in all languages.

To print a photo from the computer (Windows)

1. Load paper in the input tray. For more information, see Load paper.

2. From your software, select Print.

3. Make sure your printer is selected.

4. To change settings, click the button that opens the Preferences dialog box.

Depending on your software application, this button might be called Properties , Options , Printer 
Setup , Printer , or Preferences .

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. Select the appropriate options on the Printing Shortcut tab.

To change other print settings, click the other tabs.

For more printing tips, see Tips for print success.

6. Click OK to confirm the setups. The Preferences window closes.

7. Click Print or OK to begin printing.
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NOTE: After the printing is finished, remove unused photo paper from the input tray. Store the photo paper 
so it does not start to curl, which could reduce the quality of your printout.

To print a photo from the computer (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

● Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the paper size ensure that you have loaded the correct paper.

● Select the Orientation.

4. From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:

● Paper Type: The appropriate photo paper type

● Quality: Select the option that provides the best quality or maximum dpi.

● Click the Color Options disclosure triangle, and then choose the appropriate Photo Fix option.

— Off: applies no changes to the image.

— On: automatically focuses the image; moderately adjusts image sharpness.

5. Select any other print settings you want, and then click Print.

To print photos from a USB flash drive

You can print a photo from a USB flash drive directly without using a computer.

1. Insert a USB flash drive into the USB port on the bottom right side of the printer.

2. Wait for the files and folders on the flash driver to display on the control panel screen.

3. On the control panel display, choose a photo that you want to print and touch Continue.

4. Scroll up or down to specify the number of photos to print.

5. Touch Done and touch Continue to preview the selected photo. If you wish to adjust layout or paper
type, touch  (Setup), and then touch your selection.

6. Touch Print to begin printing.

Print on special and custom-size paper
If your application supports custom-size paper, set the size in the application before printing the document. If 
not, set the size in the printer driver. You might need to reformat existing documents to print them correctly 
on custom-size paper.

To set up custom sizes (Windows)

1. Depending on your operating system, do one of the following:
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● Windows 10: From the Windows Start menu, click All apps, select Windows System, and then click 
Devices,select Devices and printers under Related settings menu. Select the printer name, and 
select Print server properties .

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View devices 
and printers. Click or tap the printer name, and click or tap Print server properties.

● Windows 7: From the Windows Start menu, click Devices and Printers. Select the printer name, 
and select Print server properties.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers. Right-
click an empty area in the Printers window, and select Server Properties.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes. From the File menu, click Server Properties.

2. Select the Create a new form check box.

3. Enter the name of the custom size paper.

4. Enter the dimensions of the custom size in the Form description (measurements) section.

5. Click Save Form, and then click Close.

To print on special or custom-size paper (Windows)

NOTE: Before you can print on custom-size paper, you must set up the custom size in the Print Server 
Properties.

1. Load paper in the input tray. For more information, see Load paper.

2. From your software, select Print.

3. To print on special or custom-size paper.

4. Click the button that opens the Preferences dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. On the Layout tab or Paper/Quality tab, click the Advanced button.

6. In the Paper/Output area, select the custom size from the Paper Size drop-down list.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray.

7. Select any other print settings that you want, and then click OK.

8. Click Print or OK to begin printing.

To print on special or custom-size paper (OS X)

Before you can print on custom-size paper, you must set up the custom size in the HP software.

1. Load the appropriate paper in the tray.

2. Create the new custom paper size.
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a. In the software you want to print from, click File, and then click Print.

b. Make sure your printer is selected.

c. Click Manage Custom Sizes in the Paper Size pop-up menu.

If you do not see options on the Print dialog, click Show Details.

d. Click +, and then select the new item in the list and type a name for the custom paper size.

e. Enter the height and width for your custom paper.

f. Click Done or OK, and then click Save.

3. Use the created custom paper size to print.

a. From the File menu in your software application, click Print.

b. Make sure your printer is selected.

c. Choose the custom paper size name you created in the Paper Size pop-up menu.

d. Select any other print settings you want, and then click Print.

Print on both sides (manually)
To print on both sides of the page (Windows)

1. Load paper in the input tray. For more information, see Load paper.

2. From your software, select Print.

3. Make sure your printer is selected.

4. To change settings, click the button that opens the Preferences dialog box.

Depending on your software application, this button might be called Properties , Options , Printer 
Setup , Printer , or Preferences .

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. On the Layout tab, choose either Flip on Long Edge or Flip on Short Edge from the Print on Both Sides 
Manually drop-down list.

To choose the page size, on the Layout or Paper/Quality tab, click the Advanced button, and then 
choose a proper size from the Paper Size drop-down list.

To change other print settings, click the other tabs.

For more printing tips, see Tips for print success.

NOTE: If you change the paper size, be sure to load the correct paper in the input tray and set the 
paper size on the printer control panel.

6. Click OK to confirm the setups. The Preferences window closes.

7. Click Print or OK to begin printing.

8. After one side is printed, follow onscreen instructions to reload the paper back into the input tray.

9. Click Continue in the onscreen instructions to print the other side of the paper.
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To print on both sides of the page (OS X)

1. From the File menu in your software, choose Print.

2. In the Print dialog, choose Paper Handling from the pop-up menu and set Page Order to Normal.

3. Set Pages to Print to Odd Only.

4. Click Print.

5. After all of the odd numbered pages have printed, remove the document from the output tray.

6. Reload the document so that the end that came out of the printer is now going into the printer and the 
blank side of the document is facing toward the front of the printer.

7. In the Print dialog, return to the Paper Handling pop-up menu and set the page order to Normal and the 
pages to print to Even Only.

8. Click Print.

Print with mobile devices
Print from mobile devices

You can print documents and photos directly from your mobile devices, including iOS, Android, Windows 
Mobile, Chromebook and Amazon Kindle.

To print from mobile devices

1. Make sure your printer is connected to the same network as your mobile device.

2. Enable printing on your mobile device:

● iOS: Use the Print option from the Share menu. No setup is required since iOS AirPrint is 
preinstalled.

NOTE: Devices running iOS 4.2 or later have AirPrint preinstalled.

● Android: Download the HP Print Service Plugin (supported by most Android devices) from the 
Google Play Store and enable it on your device.

NOTE: Devices running Android 4.4 or later are supported by the HP Print Service Plugin. Devices 
running Android 4.3 or earlier can print using the HP ePrint app, available in the Google Play Store. 

● Windows Mobile: Tap Print from the Device menu. No setup is required since the software is 
preinstalled.

NOTE: If your printer is not listed, you might need to do a one-time setup of the printer using the 
Add Printer wizard. 

● Chromebook: Download and install the HP Print for Chrome app from the Chrome Web Store to 
enable both Wi-Fi and USB printing.

● Amazon Kindle Fire HD9 and HDX: The first time you select Print on your device, the HP Print 
Service Plugin is automatically downloaded to enable mobile printing.
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NOTE: For detailed information about enabling printing from your mobile devices, visit 
www.hp.com/go/mobileprinting. If a local version of this website is not available in your country/region 
or language, you might be directed to the HP Mobile Printing website in another country/region or 
language. 

3. Make sure the loaded paper matches the paper settings of the printer (see Load paper for more 
information). Accurately setting the paper size for the paper that is loaded enables your mobile device to 
know what paper size it is printing.

Access printer features and troubleshooting information from mobile devices
The HP All-in-One Printer Remote app helps you set up and use your HP printer for printing, scanning, storing, 
and sharing documents from virtually anywhere. It can also report printer status, perform maintenance tasks, 
order original HP printing supplies, identify and resolve printer errors, and provide troubleshooting assistance 
and support from HP.

HP All-in-One Printer Remote is supported on iOS, Android and Windows Mobile. Install it from the App Store 
or Google Play Store to enhance the capabilities of your printer.

NOTE: Some features might not be available with all printer models. Also, at this time, HP All-in-One Printer 
Remote might not be available in all languages. For more information, visit www.hp.com/support.

Tips for print success
Software settings selected in the print driver only apply to printing, they do not apply to copying or scanning.

You can print your document on both sides of the paper. For more information, see Print on both sides 
(manually).

Ink tips

● If the print quality is not acceptable, see Printing issues for more information.

● Use Original HP cartridges.

Original HP cartridges are designed and tested with HP printers and papers to help you easily produce 
great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs 
required as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased Original HP cartridges, go to www.hp.com/go/anticounterfeit.

● Install both the black and color cartridges correctly.

For more information, see Replace the cartridges.

● Check the estimated ink levels in the cartridges to make sure there is sufficient ink.

Ink level warnings and indicators provide estimates for planning purposes only.

For more information, see Check the estimated ink levels.

● Always turn off the printer with  (Power) to allow the printer to protect the nozzles.
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Paper loading tips

For more information, also see Load paper.

● Ensure the paper is properly loaded in the input tray and then adjust the paper-width guides. Change the 
paper settings if the paper size is not correctly detected.

● Load a stack of paper (not just one page). All the paper in the stack should be of the same size and type 
to avoid a paper jam.

● Load paper with the print-side up.

● Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

● Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the guides do 
not bend the paper in the tray.

Printer settings tips (Windows)

● To change default print settings, click Print & Scan, and then click Set Preferences in the HP printer 
software.

Open the HP printer software. For more information, see Open the HP printer software (Windows).

● To select the number of pages to print per sheet, on the Layout tab of the printer driver, select the 
appropriate option from the Pages per Sheet drop-down list.

● If you want to change the page orientation, set it in your application interface.

● To view more printing settings, on the Layout or Paper/Quality tab of the printer driver, click the 
Advanced button to open the Advanced Options dialog box.

NOTE: The preview on the Layout tab cannot reflect what you select from the Pages per Sheet 
Layout, the Booklet, or the Page Borders drop-down lists.

— Print in Grayscale: Allows you to print a black and white document using the black ink only. Select 
Black Ink Only, and then click the OK button.

— Pages per Sheet Layout: Helps you specify the order of the pages if you print document in more 
than two pages per sheet.

— Borderless Printing: Select this feature to print photos without border. Not all paper types support 
this feature. You will see an alert icon beside the option if the selected paper type in the Media 
drop-down list does not support it.

— HP Real Life Technologies: This feature smooths and sharpens images and graphics for improved 
print quality.

— Booklet: Allows you to print a multiple-page document as a booklet. It places two pages on each 
side of a sheet that can then be folded into a booklet in half size of the paper. Select a binding 
method from the drop-down list, and then click OK.
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○ Booklet-LeftBinding: The binding side after folded into a booklet appears at the left side. 
Select the option if your reading habit is from left to right.

○ Booklet-RightBinding: The binding side after folded into a booklet appears at the right side. 
Select the option if your reading habit is from right to left.

— Page Borders: Allows you to add the borders to the pages if you print the document with two or 
more pages per sheet.

● You can use printing shortcut to save time setting printing preferences. A printing shortcut stores the 
setting values that are appropriate for a particular kind of job, so that you can set all the options with a 
single click.

To use it, go to the Printing Shortcuts tab, select a printing shortcut, and then click OK.

To add a new printing shortcut, after making settings, click Save As and enter a name, and then click OK.

To delete a printing shortcut, select it, and then click Delete.

NOTE: You cannot delete the default printing shortcuts.

Printer settings tips (OS X)

● On the Print dialog, use the Paper Size pop-up menu to select the size of paper loaded in the printer.

● On the Print dialog, choose the Paper Type/Quality pop-up menu and select the appropriate paper type 
and quality.
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4 Copy and scan

You can produce high-quality color and black-and-white copies on a variety of paper types and sizes.

NOTE: For better copy quality, use color copy and avoid copying under direct sunlight or intense light.

● Copy

● Scan

● Tips for copy and scan success

Copy
To copy documents

1. Make sure you have paper loaded in the input tray. For more information, see Load paper.

2. Place your original print-side down in the document feeder. For more information, see Load an original 
in the document feeder.

3. From the printer control panel display, touch Copy.

4. Select Document.

5. Scroll left or right to select the number of copies.

TIP: To save these settings as defaults for future jobs, from the printer control panel display, touch 
Copy, touch  (Setup), and then touch Save Current Settings.

6. Touch Start Black or Start Color to start the copy job.

Copy settings

You can customize copy jobs using the various settings available from the printer control panel.

In the Copy menu, touch  (Setup) and change the desired settings.

● Resize

● Paper Size and Type

● Quality

● Lighter/Darker

● Enhancements

● Binding Margin

● Save Current Settings

● Restore Factory Defaults
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Scan
You can scan documents, photos and other paper types, and send them to a variety of destinations, such as a 
computer or an email recipient.

When scanning documents with the HP printer software, you can scan to a format that can be searched and 
edited.

NOTE: Some scan functions are only available after you have installed the HP printer software.

TIP: If you have problems scanning documents, see Scan issues.

● Scan to a computer

● Scan to a USB

● Scan to email

● Scanning documents as editable text

● Create a new scan shortcut (Windows)

● Change scan settings (Windows)

Scan to a computer
Before scanning to a computer, make sure you have already installed the HP recommended printer software. 
The printer and computer must be connected and turned on.

In addition, on Windows computers, the printer software must be running prior to scanning.

You can use the HP printer software to scan documents into editable text. For more information, see Scanning 
documents as editable text.

To scan an original from the printer control panel

1. Load your original print-side down in the document feeder.

For more information, see Load an original in the document feeder.

2. Touch Scan, and then select Computer.

3. Touch a computer that you want to scan to.

4. Select the desired scan type.

● Save as PDF

● Save as JPEG

● Save as Editable Text (OCR)

● Email as PDF

● Email as JPEG

● Everyday Scan

5. Touch Start Scan .

To enable the scan to a computer feature (Windows)

If the printer is connected to the computer with a USB connection, the feature for scanning to computer is 
enabled by default and cannot be disabled.
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If you are using network connection, follow these instructions if the feature has been disabled, and you wish 
to enable it again.

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. Go to the Scan section.

3. Select Manage Scan to Computer.

4. Click Enable.

To enable the scan to a computer feature (OS X)

The scan to a computer feature is enabled by default from the factory. Follow these instructions if the feature 
has been disabled, and you wish to enable it again.

1. Open HP Utility.

NOTE:  HP Utility is located in the HP folder in the Applications folder. 

2. Under Scan Settings, click Scan to Computer.

3. Ensure that Enable Scan to Computer is selected.

To scan an original from HP printer software (Windows)

1. Load your original print-side down in the document feeder.

For more information, see Load an original in the document feeder.

2. Open the HP printer software. For more information, see Open the HP printer software (Windows).

3. Go to the Scan section, click Scan a Document or Photo

4. Select the desired scan type.

● Save as PDF

● Save as JPEG

● Save as Editable Text (OCR)

● Email as PDF

● Email as JPEG

● Everyday Scan

NOTE:

● The initial screen allows you to review and modify basic settings. Click the More link at the top 
right corner of the Scan dialog to review and modify detailed settings.

● For more information, see Change scan settings (Windows).

● If Show Viewer After Scan is selected, you can make adjustments to the scanned image in the 
preview screen.

5. Click Scan.

6. Select Save if you want to keep the application open for another scan, or select Done to exit the 
application.

After the scan is saved, Windows Explorer will open the directory where the scan was saved.
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To scan an original from HP printer software (OS X)

1. Open HP Easy Scan.

HP Easy Scan is located in the Applications folder.

2. Choose the type of scan profile you want.

3. Click Scan.

Scan to a USB
You can scan directly to a USB flash drive from the printer control panel without using a computer or the HP 
printer software provided with the printer.

CAUTION: Do not remove the flash drive from the printer USB port while it is being accessed by the printer. 
This can damage the files on the USB flash drive. You can safely remove a USB flash drive only when the USB 
port light is not blinking.

NOTE:

● The printer does not support encrypted USB flash drives.

● You can also use the HP printer software to scan documents into editable text. For more information, 
see Scanning documents as editable text.

To scan an original to a USB from the printer control panel

1. Load your original print-side down in the document feeder.

2. Insert a USB flash drive.

3. Touch Scan, and then select USB.

4. Make changes to scan options, if needed.

5. Touch Start Scan.

Scan to email
The Scan-to-Email App is an application that allows you to quickly scan and email photos or documents to the 
specified recipients directly from your HP All-in-One printer. You can set up your email addresses, log in to 
your accounts with the given PIN codes, and then scan and email your documents.

This section contains the following topics:

● Set up Scan to Email

● Scan a document or photo to email

● Change account settings

Set up Scan to Email

To set up Scan to Email

1. Enable Web Services on the printer. For more information, see Set up Web Services.

2. From Home screen, touch Apps, and then touch Scan-to-Email app.

3. On the Welcome screen, touch Continue.

4. Touch in the Email box to enter your email address, and then touch Done.
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5. Touch Continue.

6. A PIN will be sent to the email address you entered. Touch Continue.

7. Touch the PIN to enter your PIN and then touch Done.

8. Touch Store Email or Auto-login, depending upon how you want the printer to store your login 
information.

9. Select your scan type by touching Photo or Document.

10. For photos, select the scan settings, and touch Continue.

For documents, continue with the next step.

11. Verify the email information, and touch Continue.

12. Touch Scan to Email.

13. Touch OK when the scan completes, and then touch Yes to send another email, or No to finish.

Scan a document or photo to email

To scan a document or photo to email from the control panel

1. Load your original print-side down in the document feeder.

2. From Home screen, touch Apps, and then touch Scan-to-Email app.

3. On the control panel display, select the account that you want to use, and touch Continue.

NOTE: Select My account is not listed if you do not have an account. You will be prompted to enter 
your email address and receive a PIN.

4. If prompted, enter the PIN.

5. Select your scan type by touching Photo or Document.

6. For photos, select the scan settings, and touch Continue.

For documents, continue with the next step.

7. To add or remove recipients, touch Modify Recipient(s), and when finished touch Done.

8. Verify the email information and touch Continue.

9. Touch Scan to Email.

10. Touch OK when the scan completes, and then touch Yes to send another email, or No to finish.

To scan a document or photo to email from HP printer software (Windows)

1. Load your original print-side down in the document feeder.

2. Open the HP printer software. For more information, see Open the HP printer software (Windows).

3. In the printer software, click Scan a Document or Photo .

4. Select the type of scan you want and then click Scan .

Choose Email as PDF or Email as JPEG to open your email software with the scanned file as an 
attachment.
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NOTE:

● The initial screen allows you to review and modify basic settings. Click the More link at the top 
right corner of the Scan dialog to review and modify detailed settings.

● For more information, see Change scan settings (Windows).

Change account settings

To change account settings from the printer control panel

1. From Home screen, touch Apps, and then touch Scan-to-Email app.

2. Select the account that you want to change, and touch Modify.

3. Select which setting you want to modify, and follow the onscreen prompts.

● Auto-login

● Store Email

● Remove from list

● Change PIN

● Delete Account

Scanning documents as editable text
When scanning documents, you can use the HP software to scan documents into a format that you can 
search, copy, paste, and edit. This allows you to edit letters, newspaper clippings, and many other documents.

● Scan documents as editable text

● Guidelines for scanning documents as editable text

Scan documents as editable text

Use the following guidelines for scanning documents as editable text.

To scan a document to editable text (Windows)

You can scan different types of printed documents into a format in which you can search and edit.

If Save as Editable Text (OCR) is not in the list of available scan options, you need to reinstall your software 
and choose that option.

1. Load your original print-side down in the document feeder.

2. Open the HP printer software. For more information, see Open the HP printer software (Windows).

3. In the printer software, click Scan a Document or Photo.

4. Select Save as Editable Text (OCR) and click Scan.

NOTE:

● The initial screen allows you to review and modify basic settings. Click the More link at the top 
right corner of the Scan dialog to review and modify detailed settings.

● For more information, see Change scan settings (Windows).

● If Show Viewer After Scan is selected, you can make adjustments to the scanned image in the 
preview screen.
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To scan documents as editable text (OS X)

1. Load your original print-side down in the document feeder.

2. Open HP Easy Scan.

HP Easy Scan is located in the Applications folder.

3. Click the Scan button.

A dialog appears requesting confirmation of your scanning device and the scan settings preset.

4. Follow the onscreen instructions to complete the scan.

5. When all of the pages have been scanned, select Save from the File menu.

6. Select the type of editable text you want from the Format pop-up menu.

7. Click Save.

Guidelines for scanning documents as editable text

Use the following guidelines to ensure the software successfully converts your documents.

● Make sure the document feeder window is clean.

Smudges or dust on the scan glass or document feeder window can prevent the software from 
converting the document to editable text.

● Make sure the document is loaded correctly.

Make sure the original is properly loaded and that the document is not skewed.

● Make sure the text on the document is clear.

To successfully convert the document to editable text, the original must be clear and of high quality.

The following conditions can cause the software to not convert the document successfully:

— The text on the original is faint or wrinkled.

— The text is too small.

— The structure of the document is too complex.

— The text is tightly spaced. For example, if the text that the software converts has missing or 
combined characters, "rn" might appear as "m."

— The text is on a colored background. Colored backgrounds can cause images in the foreground to 
blend too much.

● Choose the correct profile.

Be sure to select a shortcut or preset that allows scanning as editable text. These options use scan 
settings designed to maximize the quality of your OCR scan.

Windows: Use the Editable Text (OCR) or Save as PDF shortcuts.

OS X: Use the Documents with Text preset.

● Save your file in the correct format.

If you want to extract just the text from the document, without any of the formatting of the original, 
select a plain text format, such as Text (.txt) or TXT.
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If you want to extract the text, as well as some of the formatting of the original, select Rich Text Format, 
such as Rich Text (.rtf) or RTF, or searchable PDF format, such as Searchable PDF (.pdf) or Searchable 
PDF .

Create a new scan shortcut (Windows)
You can create your own scan shortcut to make scanning easier. For example, you might want to regularly 
scan and save photos in PNG format, rather than JPEG.

1. Load your original print-side down in the document feeder.

2. Open the HP printer software. For more information, see Open the HP printer software (Windows).

3. In the printer software, click Scan a Document or Photo .

4. Click Create New Scan Shortcut .

5. Enter a descriptive name, choose an existing shortcut on which to base your new shortcut, and then click 
Create .

For example, if you are creating a new shortcut for photos, choose either Save as JPEG or Email as 
JPEG . This makes available the options for working with graphics when scanning.

6. Change the settings for your new shortcut to meet your needs, and then click the save icon to the right 
of the shortcut.

NOTE:

● The initial screen allows you to review and modify basic settings. Click the More link at the top 
right corner of the Scan dialog to review and modify detailed settings.

● For more information, see Change scan settings (Windows).

Change scan settings (Windows)
You can modify any of the scan settings either for a singular use or save the changes to use permanently. 
These settings include options such as page size and orientation, scan resolution, contrast, and the folder 
location for saved scans.

1. Load your original print-side down in the document feeder.

2. Open the HP printer software. For more information, see Open the HP printer software (Windows).

3. In the printer software, click Scan a Document or Photo.

4. Click the More link in the top right corner of the HP Scan dialog.

The detailed settings pane appears on the right. The left column summarizes the current settings for 
each section. The right column allows you to change the settings in the highlighted section.

5. Click each section at the left of the detailed settings pane to review the settings in that section.

You can review and change most settings using drop-down menus.

Some settings allow greater flexibility by displaying a new pane. These are indicated by a + (plus sign) at 
the right of the setting. You must either accept or cancel any changes on this pane to return to the 
detailed settings pane.

6. When you have finished changing settings, do one of the following.
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● Click Scan. You are prompted to save or reject the changes to the shortcut after the scan is 
finished.

● Click the save icon to the right of the shortcut. It saves the changes into the shortcut so that you 
can reuse them next time. Otherwise, the changes only affect the current scan. Then click Scan.

Go online to learn more about using the HP Scan software. Learn how to:

● Customize scan settings, such as image file type, scan resolution, and contrast levels.

● Scan to network folders and cloud drives.

● Preview and adjust images before scanning.

Tips for copy and scan success
Use the following tips to copy and scan successfully.

● To make a large copy of a small original, scan the original into the computer, resize the image in the 
scanning software, and then print a copy of the enlarged image.

● If you want to adjust scan size, output type, scan resolution, or file type, and so on, start scan from the 
printer software.

● To avoid incorrect or missing scanned text, make sure the brightness is set appropriately in the 
software.

● If you want to scan a document with several pages into one file instead of multiple files, start the scan 
with the printer software instead of selecting Scan from the printer display.

● For optimal quality, avoid copying or scanning under direct sunlight or intense lighting.
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5 Web services

The printer offers innovative, web-enabled solutions that can help you quickly access the Internet, obtain 
documents, and print them faster and with less hassle—and all without using a computer.

NOTE:  To use these web features, the printer must be connected to the Internet. You cannot use these web 
features if the printer is connected using a USB cable.

This section contains the following topics:

● What are Web Services?

● Set up Web Services

● Use Web Services

● Remove Web Services

What are Web Services?
HP ePrint

● HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled printer anytime, 
from any location. It's as simple as sending an email to the email address assigned to your printer when 
you enable Web Services on the printer. No special drivers or software are needed. If you can send an 
email, you can print from anywhere, using HP ePrint .

NOTE: You can sign up for an account on HP Connected (www.hpconnected.com). This site might not 
be available in all countries/regions, and sign in to configure the ePrint settings.

Once you have signed up for an account on HP Connected (www.hpconnected.com). This site might not 
be available in all countries/regions, you can sign in to view your HP ePrint job status, manage your HP 
ePrint printer queue, control who can use your printer's HP ePrint email address to print, and get help 
for HP ePrint .

Print apps

● With print apps, you can scan and store your documents digitally on the Web, and also access and share 
the content, and do more.

Set up Web Services
Before you set up Web Services, make sure your printer is connected to the Internet.

To set up Web Services, use one of the following methods.

To set up Web Services using the printer control panel

1. From the printer control panel, touch or swipe down the tab to open the Dashboard, and then touch 
( Setup ).

2. Touch Web Services Setup .

3. Touch Accept to accept the Web Services terms of use and enable Web Services.
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4. On the screen that appears, touch OK to allow the printer to automatically check for product updates.

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the onscreen 
instructions to set up a proxy server. If you do not have the proxy details, contact your network 
administrator or the person who set up the network.

5. If the Printer Update Options screen is displayed, select one of the options.

6. When the printer is connected to the server, the printer prints an information page. Follow the 
instructions on the information page to finish the setup.

To set up Web Services using the embedded web server

1. Open the EWS. For more information, see Open the embedded web server.

2. Click the Web Services tab.

3. In the Web Services Settings section, click Setup , click Continue, and follow the onscreen instructions 
to accept the terms of use.

4. If prompted, choose to allow the printer to check for and install printer updates.

NOTE:

● When updates are available, they are automatically downloaded and installed, and then the printer 
restarts.

● If prompted for proxy settings and if your network uses proxy settings, follow the onscreen 
instructions to set up a proxy server. If you do not have the proxy details, contact your network 
administrator or the person who set up the network.

5. When the printer is connected to the server, the printer prints an information page. Follow the 
instructions on the information page to finish the setup.

To set up Web Services using the HP printer software (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. In the window that appears, double-click Print & Scan and then select Connect Printer to the Web under 
Print. The printer's home page (embedded web server) opens.

3. Click the Web Services tab.

4. In the Web Services Settings section, click Setup , click Continue, and follow the onscreen instructions 
to accept the terms of use.

5. If prompted, choose to allow the printer to check for and install printer updates.

NOTE:

● When updates are available, they are automatically downloaded and installed, and then the printer 
restarts.

● If prompted for proxy settings and if your network uses proxy settings, follow the onscreen 
instructions to set up a proxy server. If you do not have the proxy details, contact your network 
administrator or the person who set up the network.

6. When the printer is connected to the server, the printer prints an information page. Follow the 
instructions on the information page to finish the setup.
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Use Web Services
The following section describes how to use and configure Web Services.

● HP ePrint 

● Print apps

HP ePrint
To use HP ePrint , do the following:

● Be sure you have an Internet- and email-capable computer or mobile device.

● Enable Web Services on the printer. For more information, see Set up Web Services.

TIP: For more information about managing and configuring HP ePrint settings and to learn about the latest 
features, visit HP Connected .This site might not be available in all countries/regions.

To print documents using HP ePrint

1. On your computer or mobile device, open your email application.

2. Create a new email message, and then attach the file that you want to print.

3. Enter the HP ePrint email address in the “To” field, and then select the option to send the email 
message.

NOTE: Do not enter any additional email addresses in either the "To" or "Cc" fields. The HP ePrint 
server does not accept print jobs if there are multiple email addresses.

To customize the HP ePrint email address

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, and then touch  ( HP ePrint ).

2. Touch Print Info. The printer prints an information page that contains the printer code and instructions 
on how to customize the email address.

To turn off HP ePrint

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, touch  ( HP ePrint ), and then touch  (Web Services Settings).

2. Touch HP ePrint , and then touch Off .

NOTE: To remove all Web Services, see Remove Web Services.

Print apps
With print apps, you can scan and store your documents digitally on the Web, and also access and share the 
content, and do more.

To use print apps

1. From the Home screen, then touch Apps .

2. Touch the print app you want to use.
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TIP:

● To learn more about individual print apps and to add, configure, or remove print apps, visit HP 
Connected (www.hpconnected.com). This site might not be available in all countries/regions.

● You can also turn off print apps from EWS. To do so, open EWS (see Embedded web server), click the Web 
Services tab and turn off the setting; or click the Settings tab, and select the desired option on the 
Administrator Settings page.

Remove Web Services
Use the following instructions to remove Web Services.

To remove Web Services using the printer control panel

1. From the top of the screen, touch or swipe down the tab to open the Dashboard, touch  (HP ePrint), 

and then touch  (Web Services Settings).

2. Touch Remove Web Services.

To remove Web Services using the embedded web server

1. Open the EWS. For more information, see Open the embedded web server.

2. Click the Web Services tab, and then click Remove Web Services in the Web Services Settings section.

3. Click Remove Web Services.

4. Click Yes to remove Web Services from your printer.
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6 Work with cartridges

To ensure the best print quality from the printer, you need to perform some simple maintenance procedures.

TIP: If you have problems copying documents, see Printing issues.

This section contains the following topics:

● Information about Cartridges

● Check the estimated ink levels

● Printing with black or color ink only

● Replace the cartridges

● Order the cartridges

● Store printing supplies

● Cartridge warranty information

Information about Cartridges
The following tips help maintain HP cartridges and ensure consistent print quality.

● The instructions in this guide are for replacing cartridges, and are not intended for first time installation. 
For the first time installation, follow the instructions in the setup poster provided with the printer.

● Keep all cartridges in the original sealed packages until they are needed.

● Be sure to turn off the printer properly. For more information, see Turn the printer off .

● Do not clean the cartridge unnecessarily. This wastes ink and shortens the life of the cartridges.

● Handle cartridges carefully. Dropping, jarring, or rough handling during installation can cause temporary 
printing problems.

● If you are transporting the printer, do the following to prevent ink leaking from the printer or other 
damage from occurring to the printer:

— Make sure you turn off the printer by pressing  (Power). Wait until all sounds of internal motion 
stop before unplugging the printer.

— Make sure you leave the cartridges installed.

— The printer must be transported sitting flat; it should not be placed on its side, back, front, or top.

Check the estimated ink levels
You can check the estimated ink levels from the printer software or from the printer control panel.
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To check the estimated ink levels from the printer control panel

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard.

2. Touch  (Ink) to check the estimated ink levels.

To check the estimated ink levels from the HP printer software (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. In the printer software, from the main menu on the top, click Estimated Cartridge Levels.

To check the ink levels from the HP printer software (OS X)

1. Open HP Utility.

HP Utility is located in the HP folder in the Applications folder at the top level of the hard disk.

2. Select the printer from the Devices list.

3. Click Supplies Status.

The estimated ink levels appear.

NOTE:

● If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in another 
printer, the ink level indicator might be inaccurate or unavailable.

● Ink from the cartridges is used in the printing process in a number of different ways, including in the 
initialization process, which prepares the printer and cartridges for printing, and in printhead servicing, 
which keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the 
cartridge after it is used. For more information, see www.hp.com/go/inkusage .

Printing with black or color ink only
For regular usage, this product is not designed to print using only one cartridge. However, when one cartridge 
runs out of ink, you can remove it and use the other cartridge to continue printing.

The printer supports this capability only if the cartridge has sufficient ink. Therefore, you should replace the 
empty cartridge as soon as possible.

Replace the cartridges
If you do not already have spare cartridges, see Order the cartridges. Not all cartridges are available in all 
countries/regions.

CAUTION: HP recommends that you install any missing cartridges as soon as possible to avoid print quality 
issues and possible extra ink usage or damage to the ink system. 

For information on recycling used ink supplies, see HP inkjet supplies recycling program.

To replace the cartridges

1. Make sure the printer is turned on.
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2. Open the cartridge access door and wait for the print carriage to stop moving, which should take a few 
seconds.

CAUTION: Do not replace or install cartridges when the print carriage is still moving.

3. Open the cartridge latch as shown and gently remove the cartridge from its slot.

4. Remove the protective film from a new cartridge.

5. Insert the new cartridge into its slot at the same angle at which you removed the old cartridge, and then 
close the latch as illustrated. Press the latch to make sure it is seated flat on the cartridge.

NOTE: Install the color cartridge on the left and the black cartridge on the right.

6. Repeat steps 3 through 5 for the other cartridge if needed.

7. Close the cartridge access door.

8. Wait for the carriage to complete the cartridge initialization routine before using the printer.

NOTE: Do not open the cartridge access door until the cartridge initialization is complete
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Order the cartridges
To order cartridges, go to www.hp.com . At this time, some portions of the HP website are available in English 
only. Ordering cartridges online is not supported in all countries/regions. However, many countries have 
information on ordering by telephone, locating a local store and printing a shopping list. In addition, you can 
visit the www.hp.com/buy/supplies page to obtain information about purchasing HP products in your country.

Use only the replacement cartridges that have the same cartridge number as the cartridge you are replacing. 
You can find the cartridge number in the following places:

● On the label of the cartridge you are replacing.

● On a sticker inside the printer. Open the cartridge access door to locate the sticker.

● In the printer software, click Shop, and then click Shop For Supplies Online.

● In the embedded web server, by clicking the Tools tab, and then, under Product Information clicking Ink 
Gauge. For more information, see Embedded web server.

Store printing supplies
● Keep all cartridges in the original sealed packages until they are needed.

● Cartridges can be left in the printer for extended periods of time. However, to assure optimal cartridge 
health, be sure to turn off the printer properly when the printer is not in use. For more information, see 
Turn the printer off .

● Store cartridges at room temperature (15-35° C or 59-95° F).

Cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This 
warranty does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or 
tampered with.

During the warranty period the product is covered as long as the HP ink is not depleted and the end of 
warranty date has not been reached. The end of warranty date, in YYYY/MM format, may be found on the ink 
product.
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7 Network setup

Additional advanced settings are available from the printer's home page (embedded web server or EWS). For 
more information, see Open the embedded web server.

This section contains the following topics:

● Set up the printer for wireless communication

● Change network settings

● Use Wi-Fi Direct

● Easily connect and print with Bluetooth® Smart

Set up the printer for wireless communication
● Before you begin

● Set up the printer on your wireless network

● Change the connection type

● Test the wireless connection

● Turn on or off the wireless capability of the printer

NOTE: If you encounter problems connecting the printer, see Network and connection issues.

TIP: For more information about setting up and using the printer wirelessly, visit the HP Wireless Printing 
Center ( www.hp.com/go/wirelessprinting ).

Before you begin
Ensure the following:

● The wireless network is set up and working properly.

● The printer and the computers that use the printer are on the same network (subnet).

While connecting the printer, you might be prompted to enter the wireless network name (SSID) and a wireless 
password.

● The wireless network name is the name of your wireless network.

● The wireless password prevents other people from connecting to your wireless network without your 
permission. Depending on the level of security required, your wireless network might use either a WPA 
passphrase or WEP key.

If you have not changed the network name or the security passkey since setting up your wireless network, 
you can sometimes find them on the back or side of the wireless router.

If you cannot find the network name or the security password or cannot remember this information, see the 
documentation provided with your computer or with the wireless router. If you still cannot find this 
information, contact your network administrator or the person who set up the wireless network.
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Set up the printer on your wireless network
Use the Wireless Setup Wizard from the printer control panel display to set up wireless communication.

NOTE: Before you proceed, go through the list at Before you begin.

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, and then touch  (Wireless).

2. Touch  (Setup).

3. Touch Wireless Settings.

4. Touch Wireless Setup Wizard or Wi-Fi Protected Setup.

5. Follow the onscreen instructions to complete the setup.

If you are already using the printer with a different type of connection, such as a USB connection, follow the 
instructions in Change the connection type to set up the printer on your wireless network.

Change the connection type
After you have installed the HP printer software and connected the printer to your computer or to a network, 
you can use the software to change the connection type (for example, from a USB connection to a wireless 
connection).

To change from a USB connection to a wireless network (Windows)

Before you proceed, go through the list at Before you begin.

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. Click Tools.

3. Click Device Setup & Software.

4. Select Convert a USB connected printer to wireless. Follow the onscreen instructions.

To change from a USB connection to a wireless connection (OS X)

1. Connect the printer to your wireless network.

2. Use 123.hp.com to change the software connection to wireless for this printer.

 Learn more about how to change from a USB to wireless connection. Click here to go online for more 

information. At this time, this website might not be available in all languages.

To change from a wireless connection to a USB connection (Windows)

● Connect the printer and the computer with the provided USB cable. This USB port is at the rear of the 
printer. For the specific location, see Back view.

To change from a wireless connection to a USB connection (OS X)

1. Open System Preferences .

2. Click Printers & Scanners .
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3. Select your printer in the left pane and click - at the bottom of the list. Do the same for the fax entry, if 
there is one for the current connection.

4. Connect a USB cable to both your computer and printer.

5. Click + below the list of printers at the left.

6. Select the new USB printer from the list.

7. Choose your printer model name from the Use pop-up menu.

8. Click Add.

Test the wireless connection
Print the wireless test report for information about the printer wireless connection. The wireless test report 
provides information about the printer status, hardware (MAC) address, and IP address. If there is a problem 
with the wireless connection or if a wireless connection attempt failed, the wireless test report also provides 
diagnostic information. If the printer is connected to a network, the test report displays details about the 
network settings.

To print the wireless test report

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, touch  (Wirelss), and then touch  (Setup).

2. Touch Print Reports.

3. Touch Wireless Test Report.

Turn on or off the wireless capability of the printer
The blue Wireless light on the printer control panel is lit when the wireless capability of the printer is on.

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, touch  (Wireless), and then touch  (Setup).

2. Touch Wireless Settings.

3. Touch Wireless to switch it on or off.

Change network settings
From the printer control panel, you can set up and manage your printer's wireless connection and perform a 
variety of network management tasks. This includes viewing and changing network settings, restoring 
network defaults, and turning the wireless function on or off.

CAUTION: Network settings are provided for your convenience. However, unless you are an advanced user, 
you should not change some of these settings (such as IP settings, default gateway and firewall settings).

To print network settings report

▲ From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, touch  (Setup). touch Reports, and then touch Network Configuration Page.
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To change IP settings

The default IP setting for the IP settings is Automatic, which sets the IP settings automatically. If you are an 
advanced user and want to use different settings (such as the IP address, subnet mask, or the default 
gateway), you can change them manually.

TIP: Before setting a manual IP address, it is recommended to first connect the printer to the network using 
Automatic mode. This allows the router to configure the printer with other needed settings like subnet mask, 
default gateway and DNS address.

CAUTION: Be careful when manually assigning an IP address. If you enter an invalid IP address during the 
installation, your network components cannot connect with the printer.

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, touch  ( Setup ), and then touch Network Setup.

2. Touch Wireless Settings.

3. Touch Advanced Settings.

4. Touch IP Settings.

A message appears warning that changing the IP address removes the printer from the network. Touch 
OK to continue.

5. To change the settings manually, touch Manual (Static), and then enter the appropriate information for 
the following settings:

● IP Address

● Subnet Mask

● Default Gateway

● DNS Address

6. Enter your changes, and then select Apply.

Use Wi-Fi Direct
With Wi-Fi Direct, you can print wirelessly from a computer, smart phone, tablet, or other wireless-capable 
device—without connecting to an existing wireless network.

Guidelines for using Wi-Fi Direct

● Make sure your computer or mobile device has the necessary software.

— If you are using a computer, make sure you have installed the printer software provided with the 
printer.

If you have not installed the HP printer software on the computer, connect to Wi-Fi Direct first and 
then install the printer software. Select Wireless when prompted by the printer software for a 
connection type.

— If you are using a mobile device, make sure you have installed a compatible printing app. For more 
information about mobile printing, visit www.hp.com/go/mobileprinting.

● Make sure Wi-Fi Direct for your printer is turned on.

● Up to five computers and mobile devices can use the same Wi-Fi Direct connection.
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● Wi-Fi Direct can be used while the printer is also connected either to a computer using a USB cable or to
a network using a wireless connection.

● Wi-Fi Direct cannot be used to connect a computer, mobile device, or printer to the Internet.

● Wi-Fi Direct password: If the connection method of Wi-Fi Direct on the printer is set to Automatic, the
password will always be '12345678'. If the connection method of Wi-Fi Direct on the printer is set to
Manual, the password will be a randomly generated 8-digit code.

To obtain the Wi-Fi Direct password of the printer, from the printer control panel, touch  (Wi-Fi 
Direct). The Wi-Fi Direct password will be displayed on the control panel display.

To turn on Wi-Fi Direct

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the
Dashboard, and then touch  (Wi-Fi Direct).

2. Touch  (Setup).

3. If the display shows that Wi-Fi Direct is Off , touch Wi-Fi Direct and then switch it on.

TIP: You can also turn on Wi-Fi Direct from the EWS. For more information about using the EWS, see 
Embedded web server.

To print from a wireless-capable mobile device that supports Wi-Fi Direct

Make sure you have installed the latest version of HP Print Service Plugin on your mobile device. You can 
download this plugin from the Google Play store.

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on Wi-Fi Direct on your mobile device. For more information, see the documentation provided with
the mobile device.

3. From your mobile device, select a document from a print enabled application, and then select the option
to print the document.

The list of available printers appears.

4. From the list of available printers, choose the Wi-Fi Direct name shown such as DIRECT-**-HP OfficeJet 
XXXX (where ** are the unique characters to identify your printer and XXXX is the printer model located
on the printer), and then follow the onscreen instructions on the printer and your mobile device.

If the mobile device is not automatically connected to the printer, follow the instructions on the printer
control panel to connect to the printer. If a PIN code is displayed on the printer control panel, enter the
PIN code on your mobile device.

When the mobile device is successfully connected to the printer, the printer starts printing.

To print from a wireless-capable mobile device that does not support Wi-Fi Direct

Make sure you have installed a compatible printing app on your mobile device. For more information, 
visit www.hp.com/go/mobileprinting.

If a local version of this website is not available in your country/region or language, you might be directed to 
the HP Mobile Printing site in another country/region or language.
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1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on the Wi-Fi connection on your mobile device. For more information, see the documentation 
provided with the mobile device.

NOTE: If your mobile device does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3. From the mobile device, connect to a new network. Use the process you normally use to connect to a 
new wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks 
shown such as DIRECT-**-HP OfficeJet XXXX (where ** are the unique characters to identify your printer 
and XXXX is the printer model located on the printer).

Enter the Wi-Fi Direct password when prompted.

4. Print your document.

To print from a wireless-capable computer (Windows)

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on the computer's Wi-Fi connection. For more information, see the documentation provided with 
the computer.

NOTE: If your computer does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3. From the computer, connect to a new network. Use the process you normally use to connect to a new 
wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks shown 
such as DIRECT-**-HP OfficeJet XXXX (where ** are the unique characters to identify your printercand 
XXXX is the printer model located on the printer).

Enter the Wi-Fi Direct password when prompted.

4. Proceed to step 5 if the printer has been installed and connected to the computer over a wireless 
network. If the printer has been installed and connected to your computer with a USB cable, follow the 
steps below to install the printer software using the Wi-Fi Direct connection.

a. Open the HP printer software. For more information, see Open the HP printer software (Windows).

b. Click Tools.

c. Click Device Setup & Software, and then select Connect a new printer.

NOTE: If you have previously installed the printer over USB and want to convert to Wi-Fi Direct, 
do not select the Convert a USB connected printer to wireless option.

d. When the Connection Options software screen appears, select Wireless.

e. Select your HP printer from the detected printer list.

f. Follow the onscreen instructions.

5. Print your document.

To print from a wireless-capable computer (OS X)

1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on Wi-Fi on the computer.

For more information, see the documentation provided by Apple.
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3. Click the Wi-Fi icon and choose the Wi-Fi Direct name, such as DIRECT-**-HP OfficeJet XXXX (where ** 
are the unique characters to identify your printer and XXXX is the printer model located on the printer).

If Wi-Fi Direct is turned on with security, enter the password when prompted.

4. Add the printer.

a. Open System Preferences.

b. Depending on your operating system, click Printers & Scanners.

c. Click + below the list of printers at the left.

d. Select the printer from the list of detected printers (the word “Bonjour” is listed the right column 
beside the printer name), and click Add.

 Click here for online troubleshooting for Wi-Fi Direct, or for more help with setting up Wi-Fi Direct. At 

this time, this website might not be available in all languages.

 Learn more about how to change from a USB to wireless connection. Click here to go online for more 

information. At this time, this website might not be available in all languages.

Easily connect and print with Bluetooth® Smart
With the Bluetooth Smart technology, you can easily connect your mobile device to your printer and start 
printing. Simply walk up to the printer, select the file you want to print using the HP ePrint app, and then 
select the print option. The mobile device will connect to the printer automatically.

NOTE: Bluetooth Smart is currently supported on Android mobile devices that support Bluetooth v4.0+ and 
that have the HP ePrint app installed. For more information, visit www.hp.com/go/blueprinting. 

To connect and print using Bluetooth Smart technology

1. Set up your mobile device and printer to enable Bluetooth Smart connections.

● On your mobile device, turn on Wi-Fi and Bluetooth and install the HP ePrint app from the Google 
Play store. For more information, see the documentation provided with the mobile device.

● On the printer, make sure Bluetooth Smart and Wi-Fi Direct are turned on. For more information, 
see Use Wi-Fi Direct and To turn on or off Bluetooth Smart on the printer.

2. Walk up to within arm’s reach of the printer.

3. Open the HP ePrint app on the mobile device and select the desired content to print.

4. Confirm the correct printer is selected by the app, and select Print.

To turn on or off Bluetooth Smart on the printer

The Bluetooth feature is on by default if wireless is turned on.

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, and then touch  (Setup).

2. Scroll down to touch the Bluetooth option, and then turn it on or off.
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8 Printer management tools

This section contains the following topics:

● Toolbox (Windows)

● HP Utility (OS X)

● Embedded web server

Toolbox (Windows)
The Toolbox provides maintenance information about the printer.

NOTE: The Toolbox can be installed from the HP Software CD if the computer meets the system 
requirements. System requirements can be found in the Readme file, which is available on the HP printer 
software CD provided with your printer.

To open the Toolbox

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. Click Print & Scan.

3. Click Maintain Your Printer.

HP Utility (OS X)
HP Utility contains tools to configure print settings, calibrate the printer, order supplies online, and find 
website support information.

NOTE: The features available in HP Utility vary depending on the selected printer.

Double-click HP Utility in the HP folder in the Applications folder at the top level of the hard disk.

Embedded web server
When the printer is connected to a network, you can use the printer's embedded web server (EWS) to view 
status information, change settings, and manage it from your computer.

NOTE:

● To view or change some settings, you might need a password.

● You can open and use the embedded web server without being connected to the Internet. However, 
some features are not available.

● About cookies

● Open the embedded web server

● Embedded web server cannot be opened
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About cookies
The embedded Web server (EWS) places very small text files (cookies) on your hard drive when you are 
browsing. These files let the EWS recognize your computer the next time you visit. For example, if you have 
configured the EWS language, a cookie helps remember which language you have selected so that the next 
time you access the EWS, the pages are displayed in that language. Some cookies (such as the cookie that 
stores customer-specific preferences) are stored on the computer until you clear them manually.

You can configure your browser to accept all cookies, or you can configure it to alert you every time a cookie is 
offered, which allows you to decide which cookies to accept or refuse. You can also use your browser to 
remove unwanted cookies.

Depending on your printer, if you disable cookies, you also disable one or more of the following features:

● Using some setup wizards

● Remembering the EWS browser language setting

● Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete cookies, see 
the documentation available with your Web browser.

Open the embedded web server
You can access the embedded web server through either a network or Wi-Fi Direct.

To open the embedded web server through a wireless network

1. Make sure both your printer and computer are connected to the same wireless network.

2. From the printer control panel, touch  (Wireless) to find out the IP address or hostname of the 
printer.

3. Type such IP address or hostname in a supported web browser on your computer.

For example, if the IP address is 123.123.123.123, type the following address into the web browser: 
http://123.123.123.123.

To open the embedded web server through Wi-Fi Direct

1. From the printer control panel, touch  (Wi-Fi Direct).

2. Skip this step if the display shows the Wi-Fi Direct is on.

Touch  (Settings), and then choose On for the Wi-Fi Direct option.

3. From your wireless computer, turn wireless on, search for and connect to the Wi-Fi Direct name, for 
example: DIRECT-**-HP OfficeJet XXXX (where ** are the unique characters to identify your printer and 
XXXX is the printer model located on the printer).

4. Enter the Wi-Fi Direct password when prompted on your computer.

5. In a supported web browser on your computer, type http://192.168.223.1 into the web browser.
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Embedded web server cannot be opened
1. Restart your network router.

2. Wait until your computer and network have both reconnected to the network successfully.

3. Access the printer’s EWS again.

Check your network

● Make sure you are not using a phone cord or a crossover cable to connect the printer to the network.

Check the computer

● Make sure the computer that you are using is connected to the same network as the printer.

NOTE: You may also access the printer’s EWS if the computer is connected to the printer through Wi-Fi 
Direct. For information about how to access EWS through Wi-Fi Direct, see Embedded web server

Check your web browser

● Make sure the web browser meets the minimum system requirements. For more information, see 
system requirements in the printer's Readme file found on the HP printer software CD.

● If your web browser uses any proxy settings to connect to the Internet, try turning off these settings. For 
more information, see the documentation available with your web browser.

● Make sure JavaScript and cookies are enabled in your web browser. For more information, see the 
documentation available with your web browser.

Check the printer IP address

● To check the IP address of the printer, you can print a wireless test report. For more information about 
the wireless test report, see Test the wireless connection.

● Ping the printer using the IP address from the command prompt (Windows) or from Network Utility (OS 
X).

NOTE: To find Network Utility from OS X, click the icon Spotlight, and then type Network Utility into 
the search field.

For example, if the IP address is 123.123.123.123, type the following at the command prompt 
(Windows):

C:\ping 123.123.123.123
Or

In Network Utility (OS X), click the Ping tab, type the 123.123.123.123 in the box, and then click Ping.

If a reply appears, the IP address is correct. If a time-out response appears, the IP address is incorrect.

TIP: If you are using a computer running Windows, you can visit the HP online support website at 
www.hp.com/support. This website provides information and utilities that can help you correct many 
common printer problems.
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9 Solve a problem

The information in this section suggests solutions to common problems. If your printer is not operating 
correctly and these suggestions did not solve your problem, try using one of the support services listed in HP 
support to obtain assistance.

This section contains the following topics:

● Jams and paper-feed issues

● Printing issues

● Copy issues

● Scan issues

● Network and connection issues

● Printer hardware issues

● Get help from the printer control panel

● Understand printer reports

● Solve problems using Web Services

● Maintain the printer

● Restore original factory defaults and settings

● HP support

Jams and paper-feed issues
What do you want to do?

Clear a paper jam

Solve paper jam issues Use an HP online troubleshooting wizard.

Instructions for clearing paper jam and resolving issues with paper or the paper feed.

NOTE: The HP online troubleshooting wizards may not be available in all languages.

Read general instructions in the Help for clearing paper jams

Paper jams can occur in several locations inside the printer.

CAUTION: To prevent possible damage to the cartridge, clear paper jams as soon as possible.
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To clear a paper jam from input tray and output slot

1. Remove paper that is not jammed from both the input tray and output slot.

2. If paper is jammed in the input tray or output slot, slowly and steadily pull it out to avoid paper tear.

If you cannot remove it, it should be jammed in the printing area. Go through next steps.

3. Open the cartridge access door.

4. Remove all visible paper by moving the cartridges around from one side to the other.

If the issue is not resolved, use HP online troubleshooting wizard to resolve the cartridge jams.

5. Close the cartridge access door.

6. Check to make sure all jammed and torn pieces of paper are cleared. Otherwise, more paper jams will 
occur.

7. (Option) If the print carriage does not return to the left side of the printer, turn the printer off and on 
again.

To clear a paper jam from the document feeder

1. Lift the cover of the document feeder.

2. Pull any jammed paper out of the rollers.

CAUTION:

● If the paper tears when you are removing it from the rollers, check the rollers and wheels for torn 
pieces of paper that might remain inside the printer.

● If you do not remove all the pieces of paper from the printer, more paper jams are likely to occur.

3. Close the cover of the document feeder until it snaps into space.

To clear a paper jam from the print carriage area

1. Open the cartridge access door.
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2. Remove all visible paper by moving the cartridges around from one side to the other.

3. Close the cartridge access door.

Learn how to avoid paper jams
To help avoid paper jams, follow these guidelines.

● Remove printed papers from the output slot frequently.

● Make sure that you are printing with paper that is not wrinkled, folded, or damaged.

● Prevent curled or wrinkled paper by storing all unused paper flat in a resealable bag.

● Do not use paper that is too thick or too thin for the printer.

● Make sure that the paper is loaded correctly. For more information, see Load paper.

● Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

● Do not place too much paper in the input tray. For information on the maximum number of sheets 
allowed in the input tray, see Specifications.

● When loading a stack of paper, fan the pages first.

● Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the 
input tray must be the same size and type.

● Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the paper-width 
guides do not bend the paper in the input tray.

● Do not force paper too far inside the input tray.

● If you are printing on both sides of a page, do not print highly saturated images on light weight paper.

● Use paper types that are recommended for the printer.

● If the printer is about to run out of paper, allow the printer to run out of paper first, and then add paper. 
Do not load paper when the printer is printing.

62 Chapter 9   Solve a problem ENWW



Solve paper-feed problems
What kind of problem are you having?

● Paper is not picked up from the input tray   

— Make sure paper is loaded in the input tray. For more information, see Load paper. Fan the paper 
before loading.

— Make sure the paper-width guides are snug, but not tight, against the paper.

— Make sure paper in use is not curled. Uncurl paper by bending it in the opposite direction of the 
curl.

● Pages are skewing   

— Make sure the paper loaded in the input tray is aligned to the paper-width guides.

— Load paper into the printer only when it is not printing.

● Multiple pages are being picked up  

— Make sure the paper-width guides are snug, but not tight, against the stack of paper.

— Make sure the input tray is not overloaded with paper.

— Use HP paper for optimum performance and efficiency.

Printing issues
What do you want to do?

Fix problems with page not printing (unable to print)

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE:  This utility is only available for Windows operation system. 

Troubleshoot problems with 
print jobs not printing

Use an HP online troubleshooting wizard.

Get step-by-step instructions if the printer is not responding or printing.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Read general instructions in the Help for unable to print issues

To resolve print issues (Windows)

Make sure that the printer is turned on and that there is paper in the tray. If you are still unable to print, try 
the following in order:

1. Check for error messages from the printer display and resolve them by following the onscreen 
instructions.

2. If your computer is connected to the printer with a USB cable, disconnect and reconnect the USB cable. If 
your computer is connected to the printer with a wireless connection, confirm that the connection is 
working.

3. Verify that the printer is not paused or offline.
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To verify that the printer is not paused or offline

a. Depending on your operating system, do one of the following:

● Windows 10: From the Windows Start menu, click All apps, click Windows System, click 
Control Panel, and then click View devices and printers under Hardware and Sound menu.

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View 
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes.

b. Either double-click the icon for your printer or right-click the icon for your printer and select See 
what’s printing to open the print queue.

c. On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer 
Offline.

d. If you made any changes, try to print again.

4. Verify that the printer is set as the default printer.

To verify that the printer is set as the default printer

a. Depending on your operating system, do one of the following:

● Windows 10: From the Windows Start menu, click All apps, click Windows System, click 
Control Panel, and then click View devices and printers under Hardware and Sound menu.

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View 
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes.

b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as 
Default Printer.

d. Try using your printer again.

5. Restart the print spooler.

To restart the print spooler

a. Depending on your operating system, do one of the following:
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Windows 10

i. From the Windows Start menu, click All apps, and then click Windows System.

ii. Click Control Panel, System and Security, and then click Administrative Tools.

iii. Double-click Services.

iv. Right-click the Print Spooler, and then click Properties.

v. On the General tab, next to Startup type, make sure that Automatic is selected.

vi. If the service is not already running, under Service status, click Start, and then click OK.

Windows 8.1 and Windows 8

i. Point to or tap the upper-right corner of the screen to open the Charms bar, and then click the 
Settings icon.

ii. Click or tap Control Panel, and then click or tap System and Security.

iii. Click or tap Administrative Tools, and then double-click or double-tap Services.

iv. Right-click or touch and hold Print Spooler, and then click Properties.

v. On the General tab, next to Startup type, make sure that Automatic is selected.

vi. If the service is not already running, under Service status, click or tap Start, and then click or 
tap OK.

Windows 7

i. From the Windows Start menu, click Control Panel, System and Security, and then 
Administrative Tools.

ii. Double-click Services.

iii. Right-click the Print Spooler, and then click Properties.

iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click OK.

Windows Vista

i. From the Windows Start menu, click Control Panel, System and Maintenance, 
Administrative Tools.

ii. Double-click Services.

iii. Right-click the Print Spooler service, and then click Properties.

iv. On the General tab, next to Startup type, make sure that Automatic is selected.

v. If the service is not already running, under Service status, click Start, and then click OK.

Windows XP

i. From the Windows Start menu, right click My Computer.

ii. Click Manage, and then click Services and Applications.
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iii. Double-click Services, and then select Print Spooler.

iv. Right-click Print Spooler, and click Restart to restart the service.

b. Make sure the correct printer is set as the default printer.

The default printer has a check mark in a black or green circle next to it.

c. If the wrong printer is set as the default printer, right-click the correct printer and select Set as 
Default Printer.

d. Try using your printer again.

6. Restart the computer.

7. Clear the print queue.

To clear the print queue

a. Depending on your operating system, do one of the following:

● Windows 10: From the Windows Start menu, click All apps, click Windows System, click 
Control Panel, and then click View devices and printers under Hardware and Sound menu.

● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View 
devices and printers.

● Windows 7: From the Windows Start menu, click Devices and Printers.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes.

b. Double-click the icon for your printer to open the print queue.

c. On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to 
confirm.

d. If there are still documents in the queue, restart the computer and try printing again after the 
computer has restarted.

e. Check the print queue again to make sure it is clear, and then try to print again.

To check the power connection and reset the printer

1. Make sure the power cord is firmly connected to the printer.
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1 Power connection to the printer

2 Connection to a power outlet

2. Look at the Power button located on the printer. If it is not lit, the printer is turned off. Press the Power 
button to turn on the printer.

NOTE: If the printer is not receiving electrical power, connect it to another power outlet.

3. With the printer turned on, disconnect the power cord from the side of the printer.

4. Unplug the power cord from the wall outlet.

5. Wait at least 15 seconds.

6. Plug the power cord back into the wall outlet.

7. Reconnect the power cord to the side of the printer.

8. If the printer does not turn on by itself, press the Power button to turn on the printer.

9. Try using the printer again.

To resolve print issues (OS X)

1. Check for error messages and resolve.

2. Disconnect and reconnect the USB cable.

3. Verify that the product is not paused or offline.

To verify that the product is not paused or offline

a. In System Preferences, click Printers & Scanners.

b. Click the Open Print Queue button.

c. Click a print job to select it.

Use the following buttons to manage the print job:

● Delete: Cancel the selected print job.

● Hold: Pause the selected print job.

● Resume: Continue a paused print job.

● Pause Printer: Pause all print jobs in the print queue.

d. If you made any changes, try to print again.

4. Restart the computer.
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Fix print quality issues

Step-by-step instructions for resolving most print quality issues Troubleshoot print quality issues online

Read general instructions in the Help for resolving print quality issues

NOTE: To avoid print quality problems, always turn the printer off using the Power button, and wait until the 
Power button light goes out before you pull the plug or turn off a power strip. This allows the printer to move 
the cartridges to a capped position, where they are protected from drying out.

To improve print quality

1. Make sure you are using original HP cartridges.

2. Make sure you are using an appropriate paper type.

Always make sure the paper you are printing on is flat and is not damaged, curled, or wrinkled. For more 
information, see Tips for selecting and using paper.

For best print quality, use high quality HP paper, or papers that adhere to the ColorLok® standard. For 
more information, see Paper basics.

For best results when printing images, use HP Advanced Photo Paper.

Store specialty paper in its original packaging inside a resealable plastic bag on a flat surface in a cool, 
dry place.

When you are ready to print, remove only the paper you plan to use immediately. When you have 
finished printing, return any unused photo paper to the plastic bag. This prevents the photo paper from 
curling.

3. Make sure you have selected the appropriate paper type and print resolution in the software print 
settings.

NOTE: Selecting a higher print quality can result in a printout with higher definition but could use more 
ink and take longer to print.

4. Check the estimated ink levels to determine if the cartridges are low on ink. For more information, see 
Check the estimated ink levels. If the cartridges are low on ink, consider replacing them.

To improve print quality (Windows)

a. To print a diagnostics page 

Print a diagnostics page if the cartridges are not low on ink.

i. Load Letter or A4 plain, white paper in the input tray.

ii. Open the HP printer software. For more information, see Open the HP printer software 
(Windows).

iii. In the printer software, click Print & Scan, and then click Maintain Your Printer to access the 
Printer Toolbox.

iv. Click Print Diagnostic Information on the Device Reports tab to print a diagnostics page.

b. To clean the cartridges or printhead
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Review the blue, magenta, yellow, and black boxes on the diagnostics page. If you are seeing 
streaks in the color and black boxes, or no ink in portions of the boxes, then automatically clean 
the printhead.

i. Load Letter or A4 plain, white paper in the input tray.

ii. Open the HP printer software. For more information, see Open the HP printer software 
(Windows).

iii. In the printer software, click Print & Scan, and then click Maintain Your Printer to access the 
Printer Toolbox.

iv. From the Device Services tab, click the option to clean, and then follow the onscreen 
instructions.

If cleaning the cartridges or printhead does not solve the problem, contact HP support. Go to 
www.hp.com/support . This website provides information and utilities that can help you correct 
many common printer problems. If prompted, select your country/region, and then click All HP 
Contacts for information on calling for technical support.

c. To align the cartridges or printhead

NOTE: Aligning the printhead ensures the high-quality output. The printhead does not have to be 
realigned when cartridges are replaced.

i. Load Letter or A4 plain, white paper in the input tray.

ii. Open the HP printer software. For more information, see Open the HP printer software 
(Windows).

iii. In the printer software, click Print & Scan, and then click Maintain Your Printer to access the 
Printer Toolbox.

iv. From the Device Service tab, click the option to align.

v. The printer prints an alignment sheet.

vi. Follow the instructions on the printer screen to align.

To improve print quality (OS X)

a. To print a diagnostics page 

i. Load Letter or A4 plain, white paper in the input tray.

ii. Open HP Utility.

NOTE: HP Utility is located in the HP folder in the Applications folder.

iii. Select your printer from the list of devices at the left of the window.

iv. Click Test Page.

v. Click the Print Test Page button, and follow the onscreen instructions.

b. To clean the cartridges or printhead

i. Load Letter or A4 plain, white paper in the input tray.

ii. Open HP Utility.

NOTE: HP Utility is located in the HP folder in the Applications folder.

iii. Select your printer from the list of devices at the left of the window.
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iv. Click Clean Printheads.

v. Click Clean, and follow the onscreen instructions.

CAUTION: Clean the cartridges or printhead only when necessary. Unnecessary cleaning 
wastes ink and shortens the life of the printhead.

NOTE: If print quality still seems poor after you complete cleaning, try aligning the 
printhead. If print quality problems persist after cleaning and aligning, contact HP support. 

vi. Click All Settings to return to the Information and Support pane.

c. To align the cartridges or printhead

i. Load Letter or A4 plain, white paper in the input tray.

ii. Open HP Utility.

NOTE: HP Utility is located in the HP folder in the Applications folder.

iii. Select your printer from the list of devices at the left of the window.

iv. Click Align.

v. Click Align, and follow the onscreen instructions.

vi. Click All Settings to return to the Information and Support pane.

To improve print quality (printer control panel)

a. To print a diagnostics page 

i. Load Letter or A4 plain, white paper in the input tray.

ii. From the printer control panel, touch or swipe down the tab at the top of the screen to open 
the Dashboard, and then touch  (Setup).

iii. Touch Reports.

iv. Touch Print Quality Report.

b. To clean the cartridges or printhead

i. Load Letter or A4 plain, white paper in the input tray.

ii. From the printer control panel, touch or swipe down the tab at the top of the screen to open 
the Dashboard, and then touch  (Setup).

iii. Touch Printer Maintenance.

iv. Select the option to clean, and then follow the onscreen instructions

c. To align the cartridges or printhead

i. Load Letter or A4 plain, white paper in the input tray.

ii. From the printer control panel, touch or swipe down the tab at the top of the screen to open 
the Dashboard, and then touch  (Setup).

iii. Select the option to align, and then follow the onscreen instructions.
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Copy issues
Troubleshoot copy problems Use an HP online troubleshooting wizard.

Get step-by-step instructions if the printer does not create a copy, or if your printouts are low quality.

NOTE: The HP online troubleshooting wizards may not be available in all languages.

Tips for copy and scan success

Scan issues
HP Print and Scan 
Doctor

The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE: This utility is only available for Windows operating system.

Solve scan problems Use an HP online troubleshooting wizard.

Get step-by-step instructions if you cannot create a scan or if your scans are low quality.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Tips for copy and scan success

Network and connection issues
What do you want to do?

Fix wireless connection
Choose one of the following troubleshooting options.

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that will try to diagnose and fix the issue automatically.

NOTE: This utility is only available for Windows operating system.

Use an HP online 
troubleshooting wizard

● Troubleshoot your wireless problem, whether your printer has never been connected or it was 
connected and is no longer working.

● Troubleshoot a firewall or antivirus issue, if you suspect that it is preventing your computer from 
connecting to the printer.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.
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Read general instructions in the Help for wireless troubleshooting

Check the network configuration or print the wireless test report to assist in diagnosing network connection 
issues.

1. From the Home screen, touch  (Wireless) and then touch  (Setup).

2. Touch Print Reports, and then touch Network Configuration Page or Wireless Test Report.

Find network settings for wireless connection
Choose one of the following troubleshooting options.

HP Print and Scan Doctor The HP Print and Scan Doctor is a utility that can tell you the network name (SSID) and password (network 
key).

NOTE: This utility is only available for Windows operating system. The Windows computer you are 
running the HP Print and Scan Doctor on should be connected to the network using a wireless connection.

To check the wireless settings, open the HP Print and Scan Doctor, click on the Network tab at the top, 
select Show Advanced Info, and then select Show Wireless Info. You can also find the wireless settings by 
clicking on the Network tab at the top and selecting Open router web page.

Use an HP online 
troubleshooting wizard

Learn how to find your network name (SSID) and wireless password.

NOTE: The HP Print and Scan Doctor and the HP online troubleshooting wizards may not be available in all 
languages.

Fix Wi-Fi Direct connection

Use an HP online troubleshooting wizard Troubleshoot your Wi-Fi Direct problem or learn how to configure Wi-Fi Direct.

NOTE: The HP online troubleshooting wizards may not be available in all languages.

Read general instructions in the Help for Wi-Fi Direct troubleshooting

1. Check the printer to confirm that Wi-Fi Direct is turned on:

▲ From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, and then touch  (Wi-Fi Direct).

2. From your wireless computer or mobile device, turn on the Wi-Fi connection, and then search for and 
connect to the Wi-Fi Direct name of your printer.

3. Enter the Wi-Fi Direct password when prompted.

4. If you are using a mobile device, make sure you have installed a compatible printing app. For more 
information about mobile printing, visit www.hp.com/go/mobileprinting.

If a local version of this website is not available in your country/region or language, you might be 
directed to the HP Mobile Printing site in another country/region or language.
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Printer hardware issues
TIP:  Run the HP Print and Scan Doctor to diagnose and automatically fix printing issues. The application is 
only available in some languages. 

The printer shuts down unexpectedly

● If the printer is connected to the power:

— Check the power and power connections. Make sure the printer's power cord is connected firmly to 
a functioning power outlet.

● If the printer is disconnected from the power:

— Make sure the battery is installed properly.

— Check the battery status. For more information, see Charge the battery.

Printer alignment fails

● If the alignment process fails, make sure you have loaded unused, plain white paper into the input tray. 
If you have colored paper loaded in the input tray when you align the printer, the alignment fails.

● If the alignment process fails repeatedly, you may need to clean the cartridge, or you might have a 
defective sensor. To clean the cartridge, see Maintain the cartridge and printer .

● If cleaning the cartridge does not solve the problem, contact HP support. Go to www.hp.com/support. 
This website provides information and utilities that can help you correct many common printer 
problems. If prompted, select your country/region, and then click All HP Contacts for information on 
calling for technical support.

Resolve printer failure

Complete the following steps to resolve such problems.

1. Press  (Power) to turn off the printer.

2. Unplug the power cord.

3. Remove the battery if a battery has been installed.

4. Plug in the power cord.

5. Press  (Power) to turn on the printer.

6. Install the battery.

If this problem persists, write down the error code provided in the message, and then contact HP support. For 
more information about contacting HP support, see HP support.

Get help from the printer control panel
You can use the printer’s help topics to learn more about the printer, and some help topics include animations 
that guide you through procedures.

To access the Help menu from the Home screen or contextual help for a screen, touch  (Help) on the 
printer control panel.
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Understand printer reports
You can print the following reports to help troubleshoot problems with the printer.

● Printer status report

● Network configuration page

● Print quality report

To print a printer report

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, touch  ( Setup ).

2. Touch Reports .

3. Select a printer report to print.

Printer status report
Use the printer status report to view current printer information and cartridge status. Also use the printer 
status report to help you troubleshoot problems with the printer.

The printer status report also contains a log of recent events.

If you need to call HP, it is often useful to print the printer status report before calling.

Network configuration page
If the printer is connected to a network, you can print a network configuration page to view the network 
settings for the printer and a list of networks detected by your printer. The last page of the report includes a 
list of all detectable wireless networks in the area, along with signal strength and the channels being used. 
This might help you select a channel for your network which is not heavily used by other networks (which will 
improve network performance).

You can use the network configuration page to help troubleshoot network connectivity problems. If you need 
to call HP, it is often useful to print this page before calling.

Print quality report
Print quality problems can have many causes-software settings, a poor image file, or the printing system 
itself. If you are unhappy with the quality of your prints, a Print Quality Report page can help you determine if 
the printing system is working correctly.

Solve problems using Web Services
If you are having problems using Web Services, such as HP ePrint and print apps, check the following:

● Make sure the printer is connected to the Internet.

NOTE: You cannot use these web features if the printer is connected using a USB cable.

● Make sure the latest product updates have been installed on the printer.

● Make sure Web Services is enabled on the printer. For more information, see Set up Web Services.

● If you are connecting the printer using a wireless connection, make sure the wireless network is 
functioning properly. For more information, see Network and connection issues.
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● If you are using HP ePrint , check the following:

— Make sure the printer's email address is correct.

— Make sure that the printer's email address is the only address listed in the “To” line of the email 
message. If other email addresses are listed in the “To” line, the attachments you are sending 
might not print.

— Make sure you are sending documents that meet the HP ePrint requirements. For more 
information, visit HP Connected . This site might not be available in all countries/regions.

● If your network uses proxy settings when connecting to the Internet, make sure the proxy settings you 
are entering are valid:

— Check the settings being used by the web browser you are using (such as Internet Explorer, Firefox, 
or Safari).

— Check with the IT administrator or person who set up your firewall.

If the proxy settings used by your firewall have changed, you must update these settings in either 
the printer control panel or the embedded web server. If these settings are not updated, you will 
not be able to use Web Services.

For more information, see Set up Web Services.

TIP: For additional help on setting up and using Web Services, visit HP Connected . This site might not be 
available in all countries/regions.

Maintain the printer
What do you want to do?

Clean the exterior 

WARNING! Before cleaning the printer, turn the printer off by pressing  (Power), unplug the power cord 
from the electrical socket, and remove the battery (if installed).

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the case. Keep fluids away from the 
interior of the printer, as well as from the printer control panel.

Clean the document feeder
When the printer scans the document, smudges or dust on the scan glass can be scanned, as well, and can 
prevent the software from converting the document to editable text.

To clean the document feeder

WARNING! Before cleaning the printer, turn the printer off by pressing  (Power), unplug the power cord 
from the electrical socket, and remove the battery (if installed).

1. Remove all originals from the document feeder tray.
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2. Lift the document feeder cover.

This provides easy access to the scan glass, rollers (1) and separator pad (2).

1 Rollers

2 Separator pad

3. Lightly dampen a clean lint-free cloth with distilled water, then squeeze any excess liquid from the cloth.

4. Use the lint-free cloth to wipe any residue off the scan glass, rollers or separator pad.

NOTE: If the residue does not come off using distilled water, try using isopropyl (rubbing) alcohol.

5. Close the cover of the document feeder.

Maintain the cartridge and printer 
If you are experiencing problems with printing, you might have a problem with the cartridge. You should 
perform the procedures in the following sections only when directed to do so for resolving print quality 
issues.

Performing the aligning and cleaning procedures unnecessarily can waste ink and shorten the life of the 
cartridges.

● Clean the cartridge if your printed output is streaked or has any incorrect or missing colors.

There are three stages of cleaning. Each stage lasts about two minutes, uses one sheet of paper, and 
uses an increasing amount of ink. After each stage, review the quality of the printed page. You should 
only initiate the next phase of cleaning if the print quality is poor.

If print quality still seems poor after you complete all stages of cleaning, try aligning the printer. If print 
quality problems persist after cleaning and aligning, contact HP support. For more information, see HP 
support.

● Align the printer when the printer status page shows streaking or white lines through any of the blocks 
of color, or if you are having print quality issues with your printouts.

The printer automatically aligns the printer during the initial setup.
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NOTE: Cleaning uses ink, so clean the cartridge only when necessary. The cleaning process takes a few 
minutes. Some noise might be generated in the process.

Always use the Power button to turn off the printer. Turning the printer off improperly can cause print quality 
problems.

To clean cartridge or align printer

1. Load Letter or A4 unused plain white paper into the input tray. For more information, see Load paper.

2. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, and then touch  ( Setup ).

3. Touch Printer Maintenance , select the desired option, and then follow the onscreen instructions.

NOTE: You can also do the same from the HP printer software or embedded web server (EWS). To 
access the software or EWS, see Open the HP printer software (Windows) or Open the embedded web 
server.

Restore original factory defaults and settings
If you disable some functions or change some settings and want to change them back, you can restore the 
printer to the original factory settings or network settings.

To restore the printer to the original factory settings

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, and then touch  ( Setup ).

2. Touch Printer Maintenance .

3. Touch Restore.

4. Touch Restore Settings.

5. Select which function you would like to restore to the original factory settings:

● Copy

● Scan

● Photo

● Network

● Web Services

● Printer Setup

Touch Restore.

A message appears stating that the settings will be restored.

6. Touch Yes.

To restore the printer to the original factory defaults

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, and then touch  ( Setup ).

2. Touch Printer Maintenance .
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3. Touch Restore.

4. Touch Restore Factory Defaults.

A message appears stating that the factory defaults will be restored.

5. Touch Restore.

To restore the printer to the original network settings

1. From the printer control panel, touch or swipe down the tab at the top of the screen to open the 
Dashboard, and then touch  ( Setup ).

2. Touch Network Setup.

3. Touch Restore Network Settings.

A message appears stating that the network defaults will be restored.

4. Touch Yes.

5. Print the network configuration page and verify that the network settings have been reset.

NOTE: When you reset the printer network settings, previously configured wireless settings (such as IP 
address) are removed. The IP address is set back to the Automatic mode.

TIP:

● You can visit the HP online support website at www.hp.com/support for information and utilities that 
can help you correct many common printer problems.

● (Windows) Run the HP Print and Scan Doctor to diagnose and automatically fix printing issues. The 
application is only available in some languages.

HP support
For the latest product updates and support information, visit the printer support website at www.hp.com/
support. HP online support provides a variety of options for help with your printer:

Drivers & downloads: Download software drivers and updates, as well as product manuals and documentation 
that came in the box with your printer.

HP support forums: Visit HP Support Forums for answers to common questions and issues. You can view 
questions posted by other HP customers, or sign in and post your own questions and comments.

Troubleshooting: Use HP online tools to detect your printer and find recommended solutions.

Contact HP
If you need help from an HP technical support representative to solve a problem, visit the Contact Support 
website. The following contact options are available at no cost for in-warranty customers (HP agent-assisted 
support for out-of warranty customers may require a fee):
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Chat with an HP support agent online.

Call an HP support agent.

When contacting HP support, be prepared to provide the following information:

● Product name (Located on the printer, such as HP OfficeJet 250 Mobile All-in-One)

● Product number (located near the cartridge access area)

● Serial number (located on the back or bottom of the printer)

Register printer
By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and 
product support alerts. If you did not register your printer while installing the software, you can register now 
at http://www.register.hp.com.

Additional warranty options
Extended service plans are available for the printer at additional costs. Go to www.hp.com/support, select 
your country/region and language, then explore the extended warranty options available for your printer.
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A Technical information

This section contains the following topics:

● Specifications

● Regulatory information

● Environmental product stewardship program

Specifications
For more information, visit www.hp.com/support. Select your country or region. Click Product Support & 
Troubleshooting. Enter the name shown on the front of the printer, and then select Search. Click Product 
information, and then click Product specifications.

System requirements

● Software and system requirements can be found in the Readme file, which is available on the HP printer
software CD provided with your printer.

● For information about future operating system releases and support, visit the HP online support website
at www.hp.com/support.

Environmental specifications

● Recommended operating temperature: 15°C to 30°C (59°F to 86°F)

● Allowable operating temperature: 5°C to 40°C (41°F to 104°F)

● Humidity: 15 to 95% RH (limited to a 31°C dew point temperature)

● Nonoperating (storage) temperature: -40°C to 60°C (-40°F to 140°F)

Input tray capacity

● Plain paper sheets (64 to 100 g/m2 [104 to 163 lb]): Up to 50

● Envelopes: Up to 5

● Index cards: Up to 20

● Hagaki paper sheets: Up to 20

● Photo paper sheets: Up to 15

Paper size and weights

For the list of supported paper sizes, see the HP printer software.

● Plain paper: 64 g/m2 and above (104 lb and above)

● Envelopes: 75 to 90 g/m2 (20 to 24 lb)

● Cards: Up to 200 g/m2 (110 lb index maximum)

● Photo paper: 300 g/m2 (80 lb)
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Print specifications

● Print speeds vary according to the complexity of the document and printer model

● Method: drop-on-demand thermal officejet

● Language: PCL3

● Print resolution:

For a list of supported print resolutions, visit the www.hp.com/support.

● Print margins:

For margin settings for different medias, visit the www.hp.com/support.

Scan specifications

● Color: 24-bit color

● Maximum scan size: 216 x 356 mm (8.5 x 14 inches)

● Minimum scan size: 76 x 12.7 mm (3 x 5 inches)

Copy specifications

● Digital image processing

● Up to 50 copies from original

● Digital zoom: from 25 to 400%

● Copy speeds vary according to the selected copy quality

Cartridge yield

● Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

Regulatory information
The printer meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

● Regulatory Model Number

● FCC statement

● VCCI (Class B) compliance statement for users in Japan

● Notice to users in Japan about the power cord

● Notice to users in Korea

● Noise emission statement for Germany

● European Union Regulatory Notice

— Products with wireless functionality

● Visual display workplaces statement for Germany

● Declaration of conformity

● Regulatory information for wireless products
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— Exposure to radio frequency radiation

— Notice to users in Canada

— Notice to users in Taiwan

— Notice to users in Japan

— Notice to users in Korea

Regulatory Model Number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory 
Model Number for your product is SNPRC-1604-01. This regulatory number should not be confused with the 
marketing name (HP OfficeJet 250 Mobile All-in-One series or HP OfficeJet 258 Mobile All-in-One) or product 
number (CZ992A, N4L17A or L9D57A).

FCC statement
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VCCI (Class B) compliance statement for users in Japan

Notice to users in Japan about the power cord

Notice to users in Korea

Noise emission statement for Germany

European Union Regulatory Notice

Products bearing the CE marking comply with one or more of the following EU Directives as may be 
applicable: Low Voltage Directive 2006/95/EC, EMC Directive 2004/108/EC, Ecodesign Directive 2009/125/EC, 
R&TTE Directive 1999/5/EC, RoHS Directive 2011/65/EU. Compliance with these directives is assessed using 
applicable European Harmonised Standards. The full Declaration of Conformity can be found at the following 
website: www.hp.com/go/certificates (Search with the product model name or its Regulatory Model Number 
(RMN), which may be found on the regulatory label).

The point of contact for regulatory matters is:

HP Deutschland GmbH, HQ-TRE, Schickardstrasse 32, 71034 Boeblingen, Germany

Products with wireless functionality

EMF

● This product meets international guidelines (ICNIRP) for exposure to radio frequency radiation.
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If it incorporates a radio transmitting and receiving device that in normal use, a separation distance of 
20 cm ensures that radio frequency exposure levels comply with EU requirements.

Wireless functionality in Europe

● This product is designed for use without restrictions in all EU countries plus Iceland, Liechtenstein, 
Norway and Switzerland.

Visual display workplaces statement for Germany
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Declaration of conformity
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Regulatory information for wireless products
This section contains the following regulatory information pertaining to wireless products:

● Exposure to radio frequency radiation

● Notice to users in Canada

● Notice to users in Taiwan

● Notice to users in Japan

● Notice to users in Korea

Exposure to radio frequency radiation
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Notice to users in Canada

Notice to users in Taiwan

Notice to users in Japan
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Notice to users in Korea

Environmental product stewardship program
HP is committed to providing quality products in an environmentally sound manner. Design for recycling has 
been incorporated into this product. The number of materials has been kept to a minimum while ensuring 
proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and 
other connections are easy to locate, access, and remove using common tools. High priority parts have been 
designed to access quickly for efficient disassembly and repair. For more information, visit HP's Commitment 
to the Environment website at:

www.hp.com/hpinfo/globalcitizenship/environment

● Eco-Tips

● European Union Commission Regulation 1275/2008

● Paper 

● Plastics

● Material safety data sheets

● Recycling program

● HP inkjet supplies recycling program

● Power consumption

● Disposal of waste equipment by users

● Chemical substances

● Restriction of hazardous substance (Ukraine)

● Restriction of hazardous substance (India)

● China SEPA Eco Label User Information

● China Energy Label for Printer, Fax and Copier

● The Table of Hazardous Substances/Elements and their Content (China)

● EPEAT

● Battery disposal in Taiwan

● EU Battery Directive

● California Rechargeable Battery Take-back Notice

● United States Call2Recycle (RBRC)

Eco-Tips
HP is committed to helping customers reduce their environmental footprint. Please visit the HP 
Environmental Programs and Initiatives website for more information on HP’s environmental initiatives.

www.hp.com/hpinfo/globalcitizenship/environment/
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European Union Commission Regulation 1275/2008
For product power data, including the power consumption of the product in networked standby if all wired 
network ports are connected and all wireless network ports are activated, please refer to section P14 
‘Additional Information’ of the product IT ECO Declaration at www.hp.com/hpinfo/globalcitizenship/
environment/productdata/itecodesktop-pc.html.

Paper
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to 
identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP website at:

www.hp.com/go/msds.

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions, and 
partners with some of the largest electronic recycling centers throughout the world. HP conserves resources 
by reselling some of its most popular products.

For more information regarding recycling of HP products, please visit:

www.hp.com/recycle.

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in 
many countries/regions, and lets you recycle used cartridges free of charge. For more information, go to the 
following website:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/.

Power consumption
HP printing and imaging equipment marked with the ENERGY STAR® logo is certified by the U.S. 
Environmental Protection Agency. The following mark will appear on ENERGY STAR certified imaging 
products:

Additional ENERGY STAR certified imaging product model information is listed at: www.hp.com/go/
energystar.
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Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste. Instead, 
you should protect human health and the environment by handing over your waste 
equipment to a designated collection point for the recycling of waste electrical and electronic 
equipment. For more information, please contact your household waste disposal service, or 
go to http://www.hp.com/recycle.

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our products 
as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European 
Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/
reach.

Restriction of hazardous substance (Ukraine)

Restriction of hazardous substance (India)

China SEPA Eco Label User Information
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China Energy Label for Printer, Fax and Copier
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The Table of Hazardous Substances/Elements and their Content (China)

EPEAT

Battery disposal in Taiwan
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EU Battery Directive
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California Rechargeable Battery Take-back Notice
HP encourages customers to recycle used electronic hardware, HP original cartridges, and rechargeable 
batteries. For more information about recycling programs, go to www.hp.com/recycle.

United States Call2Recycle (RBRC)
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